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1 Introduction

Welcome to JPA Designer version 4.00, the thermal calculation program from JPA TL for car-
rying out SAP and U-value calculations and assessing the risk of interstitial condensation. JPA
Designer includes many features to make the calculation process easier:

» Project-based file system enables you to keep Uvalue and SAP 2005 calculations in
same project file;

e U-values can be linked to SAP 2005 calculations: SAP 2005 calculations are automati-
cally updated when U-values are changed;

» Calculation results can be produced as PDF files for emailing;
* Includes a database of common materials to speed U-value calculations;

* On-screen help includes the official SAP 2005 guidance.
JPA Designer is a modular program; the current modules are:

e SAP 2005 -- calculates SAP ratings to the SAP 2005 specification and tests new dwellings
for compliance with the requirements of Part L 2006.

= Uvalue Standard -- calculates U-values of building elements taking account of repeating
thermal bridges using the methods in ISO 6946 for exposed floors, walls and roofs.

= Uvalue Enhanced -- adds ground floor U-value calculations to ISO 13770 to the range
of Uvalue Standard.

= Uvalue Professional -- analyses the risk of interstitial condensation to I1SO 13788 and
carries out elemental U-value calculations to ISO 6946 and ISO 13770.

The following modules are still included in the program but have limited validity:

e SAP -- calculations to the SAP 9.70 2001 specification which was valid for use on
dwellings begun before April 2006 in England and Wales, before November 2006 in
Northern Ireland or before May 2007 in Scotland.

* SAP RI -- includes three compliance methods for the Republic of Ireland: Elemental,
Overall Heat Loss and Heat Energy Rating, which were valid until December 2006.

1



CHAPTER 1. INTRODUCTION 2

» Nondwell -- tests buildings other than dwellings for compliance against the Elemental
standards of Part L 2002, no longer valid.

For instructions on using those modules please consult version 4 of the JPA Designer manual
which is available from our web site: www.techlit.co.uk/downloads.htm.

The key code(s) you receive when you purchase the program will unlock the modules you have
bought. Other modules on the program will be visible, but will only work in demonstration
mode and will not display calculation results.You can, of course, purchase additional modules
at any time.

We hope you find JPA Designer a useful calculation tool. We are always happy to receive
comments, suggestions for improvements or proposals for enhancements to suit your specific
needs.

1.1 Getting help

This manual has been designed to provide easy reference to all the features of JPA Designer.
The manual uses the following conventions:

e <angled brackets> for keys on the computer keyboard, e.g. the <Enter=> key.

« the + sign indicates you should hold down one key while pressing another, e.g. <Alt+F>
means “hold down the <alt> key while pressing the <F> key'.

» Bold type indicates parts of JPA Designer's screen displays, e.g. the Ventilation rate
dialogue.

= Menu=>option indicates the option in the menu on the program's menu bar, e.g. Select
Edit>Primary heating system means “select the Primary heating system option from the
Edit menu'.

If you have a problem with the functioning of the software please follow these steps:

* Download and install the latest version of JPA Designer from our web site (see section

for instructions) and see if that resolves the problem, as we may already
have resolved it.

* Check the FAQ on the web site to see if the problem is addressed there.

= If the problem persists, email details of the problem to support@techlit.co.uk. Please
include details of your computer system and attach sample files or PDF outputs where
possible. We will respond as soon as we can.

If you have difficulty using the program (for example, you are uncertain how to treat an integral
garage in a SAP calculation) please follow these steps:

» Consult the program manual or on-line help system;
e Check the FAQ on the web site to see if the query is addressed there;
» Consult the SAP specification and associated documents.

 If you are new to U-value or SAP calculations you should consider attending one our
training courses, which provide a thorough introduction to the software and its use.



2 Program basics

2.1 System requirements

JPA Designer requires a PC with CD-ROM drive, running MS Windows 2000 or later. The
PC will require an internet connection if you intend to update the boiler database for the SAP
2005 module from the BRE web site, or wish to issue Energy Performance Certificates.

JPA Designer can run on Apple Macintosh computers using PC emulation software, but we do
not guarantee the software will run and do not offer technical support for running JPA Designer
on such systems.

2.2 Installation

You can install JPA Designer from the CD you received when you purchased the program or
you can download the installation file from our web site: www.techlit.co.uk. The version
available on the web site will always be the most up-to-date one.

2.2.1 Downloading the installation file from the internet

1. Using your web browser (e.g. Firefox or Internet Explorer) go to our web site at www.techlit.co.uk
and go to the downloads page.

2. Right click on the link labelled download JPA Designer and select Save link as (for Fire-
fox) or Save target as (for Internet Explorer).

3. Use the Save As dialogue to choose the folder in which to save jsetup981.exe and click
OK (we recommend downloading the file to the Desktop). The download is about 9.0
MB.

4. Once the download is complete follow the instructions in section pubsection Z.23].

2.2.2 Finding the installation software on the JPA Designer CD-ROM

—_

. Insert the JPA Designer CD-ROM into your computer's CD drive.

2. Within Microsoft Windows open My Computer and view the contents of the CD-ROM.
3. The installation file jsetup981.exe is in the main folder of the CD-ROM.
4

. Once you have found the file, follow the instructions in the next section of this manual.

3
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2.2.3 Running the installation program

To install JPA Designer:

1. Double click on the file jsetup981.exe. The WinZip Self-Extractor opens.
2. Click Setup.

3. After a few moments the Set-up program will open. The screen tell you which version
of JPA Designer is being installed. Click Next to continue with installation.

4. The Choose Destination Location screen lets you select the folder into which JPA De-
signer will be installed. We recommend you accept the default folder (c:\program
files\jpatl\jpa designer 981) and click Next.

5. The Select Program Folder screen lets you choose where to create the shortcut for JPA
Designer. Again, unless you have good reason, accept the default value (a new program
group named JPA Designer) and click Next.

6. The installer will now copy the JPA Designer files onto your computer.

7. When installation has finished the Setup Complete screen is displayed. Tick the box
labelled Yes, launch the program file then click Finish. The installer will close and JPA
Designer will open.

2.3 Updating JPA Designer

JPA Designer is often updated with improvements and new features. You can take advantage
of those developments by downloading the latest version of the software from our web site,
www.techlit.co.uk/downloads.htm.

To find out whether you have the latest version you should compare the version number on
the web site with that of the software you are using: select Help=About from the menu bar
and note the version number. The format will be JPA Designer 4.00x Build 000, where x may
include letters and numbers.

You can configure the software to check for updates automatically.

To turn on checking for updates:

1. In Program Manager select Options from the menu bar. The Options dialogue opens.

2. On the first tab of the Options dialogue tick the Check for programme updates box
(Figare Z).

If you connect to the internet using a proxy server you must tick the Use proxy server
box and enter the details for the proxy server.

3. Click OK. From now on, the software will check for updates every time you run it and
will prompt you to download a later version when it becomes available.
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Figure 2.1: The Check for programme updates options

[ Check for programme updates

[~ Use Proxy Server
Prozy server Proxy username
Frowp port [ Proxy password

If you have turned the checking facility on, but do not have an active internet connection when
you start JPA Designer you will see an error message Socket errors. If that happens, simply
click OK to dismiss the warning and carry on working as normal.

Once you have downloaded the new installation file from the web site you should install the
new version of JPA Designer in exactly the same way as you installed the original version,
using the file jsetup981.exe.

If you have added materials to the user database (see pection 4.12) we recommend you take
a backup copy of the files usercats.txt and usermats.txt before installing the new version of
the software. You should find both those files in the JPA Designer folder.

If you have issued EPCS we recommend you take a back up of the EPC database before in-
stalling an update. You can find the location of the database by selecting EPC>Database from
the menu bar.

The new installation should preserve your existing database. The database is only designed
as a temporary store for the EPC: you should use the EPC Request Management dialogue to
extract the EPCs in PDF format and save them to a secure, backed up location.

2.4 Uninstalling JPA Designer
To uninstall JPA Designer:

1. Open the Windows Add/Remove programs control panel (to access Control Panels se-
lect Settings>Control Panels from the Start button).

2. Select JPA Designer in the Add/Remove Programs Properties dialogue and click Add/Remove.
Windows will uninstall the program files and remove its icons.

2.5 Opening and closing JPA Designer
To start JPA Designer:

e Select Start>=Programs>JPA Designer=JPA Designer from the Windows Start button.
To close JPA Designer:

 Select File=Exit from the JPA Designer menu bar.
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2.6

Figure 2.2: User Registration dialogue

User Registration ﬂ

Compary MName

|Trumpt0n Builders Limited

Kev Code
|E1B? -|6751 8011 -JO0EST -|C735

CallJP& on 0191 281 83593 to buy the software and
obtain a K.ey Code

0K XK Cancel |

Unlocking modules with key codes

The licensing for JPA Designer is managed by key codes which we supply when you buy a
licence for the program.

When you first install JPA Designer the modules are locked in demonstration mode: in order
to carry out calculations you must unlock the modules by entering the key codes. (Modules
for which you have not purchased a licence remain in demonstration mode, although you can
purchase a licence and unlock them at any time.)

You unlock a module by entering the supplied user name and key code. The user name
appears on all print outs from the software.

To enter the key code for a SAP module:

1.

Start JPA Designer by selecting the program from the Start button: Start=Programs=JPA
Designer=>JPA Designer. JPA Designer opens with the Project manager window.

. From the menu bar select Insert=SAP 9.81 calculation. JPA Designer shows the De-

scription dialogue.

. Click OK to accept the default description and close the Description dialogue. JPA

Designer shows the new SAP calculation in the Project manager window.

. Double click on the new SAP calculation. The SAP module opens, with a warning

pop-up about demonstration mode.

. Click OK to dismiss the pop-up warning. The User Registration dialogue appears (see

Figire 2.2)

Enter the user name and the key code for the SAP module exactly as given then click
OK. (Please note 0 = zero).

You will need to overwrite both the default user name and the key code.

. You can now start entering data for the SAP calculation.

If you see an incorrect key code error message you should re-enter the user name and key

code.

To enter the key code for a U-value module:
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7.

. Start JPA Designer by selecting the program from the Start button: Start>Programs=JPA

Designer> JPA Designer. JPA Designer opens with the Project manager window.

. From the menu bar select Insert=>Uvalue calculation. JPA Designer shows the Descrip-

tion dialogue.

. Click OK to accept the default description and close the Description dialogue. JPA

Designer shows the new U-value calculation in the Project manager window.

Double click on the new U-value calculation. The U-value module opens, with a warn-
ing pop-up about demonstration mode.

. Click OK to dismiss the pop-up warning. The User Registration dialogue appears (see

Figure 7.2).

. Enter the user name and the key code for the U-value module exactly as given then click

OK. (Please note 0 = zero).
You will need to overwrite both the default user name and the key code.

You can now start entering data for the U-value calculation.

If you see an “incorrect key code' error message you should re-enter the user name and key

code.

If you need to change the user name because, for example, the company name has changed,
you should contact us for a new key code.

To enter a different key code for a module you have previously unlocked:

1.

2.7

In Program Manager open a SAP or U-value calculation (depending on which module
you are dealing with).

. From the menu bar select Edit>User & Security codes. The User Registration dialogue

appears.

. Enter the user name and the key code exactly as you have been given them. Click OK.

Licence management

The licence for the SAP 9.81 module has to be renewed on an annual basis. Whenever you
create or open a SAP 9.81 calculation the software attempts to connect to our on-line database
to check the validity of your licence:

= If your licence is current the SAP 9.81 calculation will open. The software will warn

you when your licence has less than 30 days to run: you should then contact JPA TL to
renew your licence.

« If your licence is not valid the software will tell you, but will not open the calculation.

You should contact JPA TL to renew your licence.

= If the software is unable to connect to the database, because your PC does not have

an internet connection, the software will display an error message and the SAP 9.81
calculation will not open.



3 Managing projects and calculations

3.1 Overview

JPA Designer organises and stores calculations in project files, enabling you to save multiple
SAP and U-value calculations in the same file. JPA Designer project files have the extension
JDP.

All work with creating and saving projects and calculations is carried out in the Project Man-
ager window. The Project Manager window lists all calculations within the project. The status
bar at the bottom of the window displays summary data for the currently selected calculation.

When JPA Designer opens it displays the Project Manager window. To return to the Project
Manager window from the Uvalue or SAP 2005 modules click the Project Manager button
on the tool bar.

3.2 Starting a new project
To create a new project:
1. Select File=New Project from the main menu, or click the New Project button on the

toolbar. JPA Designer creates a new blank project.

2. Click on the name Blank project then select Edit>Edit selected item from the menu bar.
The Description dialogue opens.

3. Type a new name for the project and click OK. JPA Designer updates the project name.

The project name does not affect the calculations in any way.

You can now start adding calculations to the project.
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Figure 3.1: The Project Information dialogue

Project Information

i Client name & address

i Project address

|-

Post Code: I

Post Code:

Phaone I

Fax I

Email |

Al b clients | E it clients list |

ceilificate

Beference / I
Date |25 June 2008

3.3 Adding project information

JPA Designer can store client details and project location for each project which can then be
copied into all calculations within that project. You can enter and edit that information using
the Project Information dialogue (Figure 3-1)). You can also store client information and reuse

it later.

To add or change project information:

1. From the menu bar select Edit>Project Information. The Project information dialogue

opens.

2. Enter the data by typing it into the appropriate fields. Use the <Tab> key to move

between fields.

Do not try to enter data in the top left hand box: this box is used for retrieving details

you have previously stored.

3. If you want to store the client details to re-use later click Add to clients.

4. Click OK when you have entered all the data you need.

To re-use existing client data simply click on the drop-down in the Project information dia-

logue and select a client from the list (see Figure 3.2).

If you need to edit the stored details click Edit clients list then make the changes in the Edit

Clients dialogue.

3.4 Saving projects

JPA Designer project are saved in the same way as any other file.

To save a project:
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Figure 3.2: Project Information dialogue, client drop-down

LClient narme & address
[Mr B T Buidler |

T rumnpton Builders Ltd

1. From the menu bar select File=Save Project. The Save As dialogue opens.

2. Select the folder into which the project should be saved, enter a name for the project
file.

By default JPA Designer will add the extension JDP to all file names.

3. Click Save. JPA Designer saves the project and displays the file name on the program
title bar.

By default JPA Designer will save files into the JPA Designer folder (usually c:\Program Files\JPATL\JPA
Designer 981). You can specify a different default folder using the Options dialogue (see

fion 3.15).

3.5 Opening projects

To open an existing project:
1. From the menu bar select File=Open project. The Open dialogue opens.

2. Select the file you want to work with, then click Open. The project opens in the Project
Manager window.

3.6 Adding calculations to a project

You can add new U-value and SAP calculations to a project in the Project Manager window.
To add a new U-value calculation to a project:

1. From the menu bar select Insert>U-value calculation. The Description dialogue opens

(Fig 3).

2. Type a name for the calculation in the Description dialogue, e.g. warm roof, and click
OK. The new calculation is added to the project.

To add a new SAP calculation to a project:

1. From the menu bar select Insert=Dwelling/SAP (v9.81 2005) calculation>Single dwelling.

The Description dialogue opens (Figure 3.3).

2. Type a name for the calculation in the Description dialogue, e.g. Plot 23, and click OK.
The new calculation is added to the project.

You can also use the Insert menu to insert calculations to versions 9.80 and 9.70 of SAP, as
well as SAP calculations for multiple dwellings.
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Figure 3.3: The Description dialogue

x

Enter a description for the dwelling:-

Ok | Cancel |

3.7 Opening calculations

To open a U-value or SAP calculation:
1. In the Project Manager window click once on the calculation name to select it.
2. From the menu bar select Edit=>Selected item. The calculation opens.

You can also open a calculation by double click on it in the Project manager window.

3.8 Closing calculations

To close a calculation and return to the Project manager window click the Project manager
button on the tool bar.

3.9 Importing existing calculations into a project

JPA Uvalue and JPA SAP were the precursors to the JPA Designer Uvalue and SAP modules.
You can import calculations carried out in those older programs into JPA Designer.
To import a JPA Uvalue calculation into JPA Designer:

1. From the menu bar select File=Import JPA Uvalue file into this project. The Open
dialogue opens.

2. Select the file you want to import and click Open. The Description dialogue opens.
3. Enter a description for the calculation and click OK.
4. The calculation will be added to the list in the Project Manager window.

You can now open the imported calculation by double-clicking on it.
To import a JPA SAP v2 calculation:

1. From the menu bar select File=Import JPA SAP file into this project. The Open dialogue
opens.

2. Select the file you want to import and click Open. The Description dialogue opens.
3. Enter a description for the calculation and click OK.
4. The calculation will be added to the list in the Project Manager window.

You can now work on the imported calculation by double clicking on it.
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3.10 Converting SAP 9.7 calculations to SAP 9.8 calculations

There may be occasions when you need to carry out a SAP 9.80 or SAP 9.81 assessment on a
dwelling originally assessed under SAP 9.70.

To convert a SAP 9.70 calculations to SAP 9.80:

1. In the Project Manager window select the SAP 9.70 calculation.
2. From the menu bar select Edit=>Copy selected SAP 9.7 2001 to SAP 9.80 2005.

3. JPA Designer converts the calculation and adds it to the project with SAP version 9.80
appended to the calculation name.

The 9.80 calculation can then updated to 9.81 by ticking the SAP version 9.81 box in
the Project Information dialogue in the SAP module (see fection 6.7))

When you open the 9.80 version of the calculation you will be prompted to add some addi-
tional pieces of information (e.g. whether or not the dwelling has been designed with accred-
ited construction details).

3.11 Merging projects

JPA Designer allows you to merge all the calculations in an existing project into the currently
open project. This can be useful if you have a number of standard calculations stored in
different projects which you need to bring together for a particular job.

To merge calculations from one project into another:
1. In Project Manager open or create the project you want to receive the calculations.

2. From the menu bar select File=Merge a project from disk into this Project. The Open
dialogue appears.

3. Select the file which contains the calculations and click Open. JPA Designer adds the
calculations to the current project and lists them in the Project Manager window.

3.12 Duplicating calculations

If you want to prepare a calculation which is very similar to an existing calculation in a project
you can duplicate the calculation and then make your changes to the duplicate.

To duplicate a calculation:
1. In the Project Manager window select the calculation by clicking on it once.
2. From the menu bar select Edit=Duplicate item. The Description dialogue opens.

3. Type a name for the duplicate calculation and click OK. A copy of the original calcula-
tion is added to the project.

You can now work with the duplicated calculation in the usual way.
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3.13 Renaming calculations
To change the name of a calculation:

1. In the Project Manager window select the calculation by clicking on it once. Its name

will be highlighted.

2. From the menu bar select Edit=Rename selected item. The Name dialogue opens.

For a U-value calculation the dialogue will the titled U-value Name and for a SAP cal-
culation it will be titled SAP name.

3. Enter a new name for the calculation and click OK. The Project Manager window shows
the new name.

Changing the name of the calculation will not affect the calculation results.

3.14 Deleting calculations

Calculations can be deleted from JPA Designer projects.
Warning: there is no way of recovering a deleted calculation.

To delete a calculation:

1. In the Project Manager window select the calculation by clicking on it once.

2. From the menu bar select Edit=>Delete selected item. JPA Designer asks you to confirm
the deletion.

3. Click Yes to delete the calculation or No to abandon the deletion. If you click Yes the
calculation is removed from the project.

3.15 Program options

There are many ways in which you can customise the performance and outputs of JPA De-
signer. Most of the options are controlled from the Options dialogue.

To open the Options dialogue, in Project Manager select Options from the menu bar.
The Options dialogue box has four tabs:
General

The General tab lets you set these options:

» Printer margins: enables you to set the page margins. If you are using headed paper
you can set the top margin for the first page to be greater than that of the second page,
which can be printed on continuation paper or blank paper.

e Company name and address: the details entered here will appear on print outs and
PDFs of U-value and SAP calculations.
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e Options: select which items which should appear on the print outs and determine
whether the program should attempt to make a back up copy of the project file.

» Uvalue Disclaimer: enter the disclaimer text to appear on print outs and PDFs of U-value
calculations.

* SAP/Nondwell disclaimer: enter the disclaimer text to appear on print outs and PDFs
of SAP and Nondwell calculations.

» Default SAP location: determines which regulations will be used for SAP calculations:
currently the choices are England and Wales, Scotland or Northern Ireland.

« Start-up folder: sets the default folder for saving and opening project files.

= Check for programme updates: lets you specify whether or not the software will check
for updated versions of JPA Designer. For more information see fection 2.3].

Logo and signature

The Logo and signature tab lets you set the following options:

» Logo position: JPA Designer can add your company logo to print outs. Use these settings
to determine the position of the logo.The logo file must be a 256 colour bitmap with
the file extension BMP, and it must be in the JPA Designer folder. Enter the name of
the file in the text box: do not include the path (e.g. enter logo.bmp not c:\Program
files\JPATL\JPA Designer 98 1\logo.bmp).

» Address position: These settings determine the position of your company address on
print outs and PDFs. Enter the address itself in the General tab.

= Certificate signature position: JPA Designer can include a digitised signature on print-
outs of SAP calculations. Use these settings to determine the position of the signature.
The signature file must be a 256 colour bitmap with the file extension, and must be
stored in the same folder as the program files.

The SAP certificate is only used with SAP 2001, version 9.70.

Email tab

In future versions of the program you will be able to email calculations directly from JPA
Designer. There is no need to provide this information in the current version of the program.

Other tab

The Other tab lets you set the default thermal conductivity of the screed in a beam and block
floor construction, and define where the preview window opens on screen.



4 U-value calculations

JPA Designer offers three U-value modules:

» Uvalue Standard calculates U-values for walls, roofs and intermediate floors using the
combined method (BS EN I1SO 6946).

= Uvalue Enhanced has all the functionality of Uvalue Standard, and also calculates U-
values for ground floors (BS EN ISO 13370).

» Uvalue Professional has the functionality of Uvalue Enhanced and also performs con-
densation risk analysis using the methods set out in BS EN 1SO 13788:2002 and BS
5250:1989 Appendix D.

Uvalue calculations are carried out in the Uvalue window by:

e Entering key information about the building element, such as the element type (e.g.wall,
floor, roof) and any special construction types (e.g. metal frame);

» Defining the materials which make up the element;

= Adding any correction factors (see pection 4.5).
You can test the effect different materials have on the thermal performance of the element by

using the variable layer feature (see Fection 4.9).

4.1 Uvalue project information

JPA Designer can store and display client and project details for each calculation. You can
either copy client and project details which you entered in the Project Information dialogue
in the Project Manager window, or you can enter new data in the Uvalue modules. You can

also save and re-use client data (see fection 3.3).
t Manager:

To copy project details from Projec

1. In the Uvalue module select Edit=Project Information from the menu bar. The Project
Information dialogue opens.

2. Click the Inherit button. Any information you entered in Project Manager is copied to
the Project Information dialogue here.

3. Click OK.
To enter new project details:

1. In the Uvalue module select Edit=Project Information from the menu bar. The Project
Information dialogue opens.

2. Enter project information by typing it into the appropriate fields. Use the <Tab> key to
move between fields. Click OK when you have entered all the data you need.

15
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Figure 4.1: The Construction details dialogue
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4.2 Construction Details

16

The thermal performance of building element will be affected by the type of element and
its position within a building. These conditions are set in the Construction details dialogue

(Figure 4

), which accepts details of:

= Element type (see Fubsection .2.1).

To enter data:

Internal and externals surfaces (see pubsection 4.2.2).
Light steel frame construction (see fubsection 4.7.1)).
Built up roofing or cladding (see fubsection 4.7.2).

= Corrections factors for fasteners and unheated spaces (see fubsection 4.5.5).

1. From the menu bar select Edit=Construction type. The Construction details dialogue
opens.

2. Enter your data and click OK.

For some constructions, such as those with mechanical fasteners, you may find it easier to
enter some of the data in the construction dialogue after you have entered the layers of the

element.
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4.2.1 Element type

JPA Designer recognises several types of element which have to be treated differently in the
calculation process. Use the radio buttons in the Element type section to select the type of
floor, wall or roof. For some elements there are options for entering additional information.

The available element types are:

» Flat roof. A roof with a pitch typically less than 15°. There is an option to enter data for

an inverted roof (see section fubsection 4.7.3).

= Pitched roof with horizontal ceiling. Typically a “cold roof' with the insulation applied
between and over the ceiling joists, although it is feasible to have a horizontal ceiling
and the insulation in the plane of the rafters. You must enter the pitch (angle) of the roof,
measured from the horizontal.

= Pitched roof with ceiling at rafter line. A warm roof' with the insulation in the plane of
the rafters.

= Wall. Any construction at an angle of more than 70° to the horizontal. There is an
option to enter data for the fixings in rainscreen cladding (see pubsection 4.5.3).

* Floor other than ground floor. A floor over an open space (e.g. a parking bay) or an
unheated space (e.g. an enclosed garage).

 Solid ground floor. A floor which is contact with the ground across its whole area, such
as groundbearing concrete slab.

= Suspended ground floor. A floor with a ventilated space below the floor deck, such as
a beam and block floor or timber joist floor.

e Basement floor.

* Basement wall.

You may also enter a description for the element in the Description box, or select one from
the drop-down list. The description does not affect the calculation

4.2.2 Internal and external surfaces

U-value calculations include allowances for the effects of the thermal resistances of the thin
layers of air on either side of the construction; the surface resistances. Those resistances
are affected by the direction of heat flow through the construction and the emissivity of the
exposed surfaces.

The surface resistances used in the calculation are shown in the two Surface Resistance boxes.
The program automatically adjusts the surface resistances according to the type of element
being considered (see fubsection 4.2.1)) and the emissivity of the surfaces, using the values

from BS EN ISO 6946 shown in [Table 4.7.

The default emissivity setting is high emissivity: as virtually every commonly specified surface
material has a high emissivity there is rarely any need to change the default.
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Table 4.1: Thermal resistances

Heat flow Element Internal resistance (Rsi)  External resistance (Rse)
Horizontal Wall, window 0.13 0.04
Upwards Roof 0.10 0.04
Downwards  Floor 0.17 0.04

4.2.3 Light steel frame construction type

U-values for light steel frame structures have to be calculated using a special method which
allows for the high thermal conductivity of steel. The Light steel-frame Construction Type
section indicates whether the structure has a light steel frame, and if so, whether it is of warm
or cold construction.

For non-steel frame structures ensure Not a light steel frame construction is selected. For

instructions for calculating U-values of light steel frame structures see section fubsection 4.7-1].

4.2.4 Built up metal roofing and cladding systems

U-values for built-up metal roofing and cladding systems have to be calculated by a special
method which takes account of the thermal bridging effects of the rails and brackets. If the
calculation is for a built-up wall or roof tick the Built-up metal roof/wall box and see section

for instructions on completing the calculation. Otherwise leave the box
blank.

4.3 Working with layers

A U-value calculation is built up by inserting layers which correspond to the layers of material
in the proposed construction. For example, a calculation for a cavity wall would have a layer
to represent the thermal performance of the outer leaf of brick, another to represent the cavity,
another for the cavity insulation and so on. There will also be layers for the surface resistances

(see section fubsection 4.2.2).

You can add layers to the calculation by inserting materials from the program's extensive
database, which includes data for generic materials and cavities, as well as branded products
from some manufacturers. For many common constructions it is possible to insert all the layers
from the database.

If you cannot find a material in the database then you can insert a blank layer and edit the
information yourself.

4.3.1 Inserting layers from the Products database

The Products database contains a wide range of materials and cavities for use in U-value

calculations and is accessed using the Products Database window (see Figure 4.2).

The Products Database window has three main parts:
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Figure 4.2: The Products Database window
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» The Categories box, which you use to select the broad category of material you want to
use. Categories of branded materials are shown in bold, categories of generic materials
in normal text and user categories in jtalics (see for information on adding

your own materials).

» The Products box, which you use to select a material from a particular category.

e The Construction box which shows the order of layers in the construction.

To insert layers using the Products Database:

. Select the existing layer which will be below the new layer.

From the menu bar select Insert>Layer from database (alternatively click the Database
button on the toolbar). The Products Database dialogue opens.

Use the scroll bar on the Categories box to find the manufacturer or type of material
you need, then click once on that category. The Products box shows the material in that

category.

. Click on a material to select it, then click the Add to construction button (alternatively
you can double click on the material in the Products box). The Thickness dialogue
opens.
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Figure 4.3: Inserting a new blank layer
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5. Enter the thickness of the layer then click OK. The Construction box now shows the new
layer. is added to the calculation and is shown in.

If the material has a set thickness the layer will be added without the Thickness dialogue
opening.

6. You can now add more layers from the database, using the Construction box to control
the position of the new layers.

7. When you have finished adding layers click the Close button. The main Uvalue window
now shows the calculation with the new layers added.

If you are not sure which category a particular material belongs to you can use the Search
button to find it.

You can use the Only show My database box to make the software only show categories which
you have added.

If you have assigned short codes to materials you can view database items sorted according
to the short code by clicking the sort by short code check box in the Products Database
dialogue. You can use short codes to select materials by entering a code in the Short Code
text box then clicking the Add to construction button. If the material does not have a set
thickness the program will prompt you to enter a thickness. For more information on short
codes see fubsection 4.12_1].

4.3.2 Inserting blank layers in a calculation

To insert a new blank layer:

1. Select the existing layer which will be below the new layer.

2. From the menu bar select Insert=Blank layer (alternatively you can press <Insert>).

The new blank layer is added to the calculation above the existing layer, see Figure 4.3).
3. Double click on the layer to open it for editing.
Because the program inserts new layers above the currently selected layer it is easiest to work

from outside to inside for wall and roof calculations and from inside to outside for floor cal-
culations.
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4.3.3 Cutting, copying and pasting layers

Cutting a layer from the calculation removes the layer, but keeps the details on the clipboard.
To cut a layer:

1. Click on the layer to select it.

2. From the menu bar select Edit>Cut layer to clipboard (alternatively click the Cut button
on the tool bar or press <Ctrl+X>). The layer is removed.

Copying a layer in a calculation copies the layer to the clipboard but keeps the original layer
in place.
To copy a layer:

1. Click on the layer to select it.

2. From the menu bar select Edit=Copy layer to clipboard (alternatively click the Copy
button on the tool bar or press <Ctrl+C=>). The layer is copied to the clipboard.

Pasting a layer inserts the layer currently in the clipboard into the calculation.
To paste a layer:

1. Click on the layer which you want to be below the pasted layer.

2. Select Edit>Paste layer from clipboard from the menu bar (alternatively click the Paste
button on the tool bar or press <Ctr1l+V=>). The layer is inserted into the calculation
above the selected layer.

4.3.4 Deleting layers
To delete a layer:
1. Click on the layer you wish to delete.

2. Press <Del>.

4.4 Working with materials

The properties of layers are entered and edited in the Edit Material dialogue (see Figure 4.3).
The dialogue enables you to set:

= Basic characteristics of the material (see pubsection 4.4.1)).
= The type of material (see pubsection 4.4.2).
= Thermal bridging (see fubsection 4.4.3).
e The air gap correction (see ).
To edit the properties of a layer:
1. Click on the layer to select.

2. From the menu bar select Edit>Layer (alternatively, double click the layer, or press
<Enter>). The Edit Material dialogue opens.

3. Amend the data for the layer and click OK.
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Figure 4.4: The Edit Material dialogue
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4.4.1 Basic characteristics

The Material section contains the basic data about the layer, including:

» Description: the name of the material or a description, which appears in the calculation.
» Short code: used with the database to sort or enter materials -- not in general use.

e Category: not in general use.

» Thickness: cross sectional thickness of the layer, measured in mm.

» Thermal conductivity: the rate of conduction heat transfer through 1m of the material,
measured in W/mK. Sometimes referred to as the lambda value or k value.

» Thermal resistance: the resistance to heat transfer provided by the layer, measured in
2
m-K/W.

* Vapour resistivity: the rate of transfer of water vapour through 1 m of the material,
measured in M Ns/gm.

= Vapour resistance: the resistance to water vapour provided by the layer, measured in
MNs/g.
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» Density: the mass per cubic metre of the material, not required for calculation.

» Specific heat capacity: the amount of energy required to raise the temperature of one
kilogram of the material by one Kelvin (roughly equivalent to 1 degree Celcius).

4.4.2 Types of materials and cavities

Layers within building elements have different combinations of properties: JPA Designer recog-
nises four types of material and three types of cavity. In addition, the program distinguishes
between materials which are thermal insulation and those which are not. The rest of this
section describes the types of layer and the data required for each one.

4.4.2.1 Normal

Normal materials have the same composition all the way through, so thermal resistance of a
normal layer is determined by the material's conductivity and thickness. A normal material
requires the following information:

* Type: select Normal.

» Description : type a description of the layer -- this will appear on the print out.
» Thickness: enter in millimetres.

« Thermal conductivity: enter in W/mK.

 The program calculates the Thermal resistance in m?K/W .

= Vapour resistivity: (only required if you will be carrying out condensation risk analysis)
enter in MNs/gm.

= The program calculates the Vapour resistance in M N s/g.

4.4.2.2 Composite materials

For composite materials, for example insulation-backed plasterboard, there is no direct link
between the conductivity, thickness and thermal resistance. You must therefore use the ther-
mal resistance which is supplied for the specific configuration of the material (this will usually
be supplied by the manufacturer of the product). A composite material requires the following
information:

Type: select Composite.

» Description : type a description of the layer -- this will appear on the print out.

Thickness: enter in millimetres.

Thermal resistance: enter in m2K/W.

Vapour resistance: (only required if you will be carrying out condensation risk analysis)
enter in MNs/g.
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4.4.2.3 Fixed vapour resistance materials

Some materials. such as glass or metals, have very high vapour resistances even when used in
thin layers. To enable the vapour resistance to be represented properly in the calculation you
should select the fixed vapour resistance category for such materials. That will break the link
between the vapour resistance and the thickness, and so prevent the vapour resistance being
reduced to an unrealistically low level by the minimal thickness.

For U-value calculations materials with fixed vapour resistances behave the same way as nor-
mal materials: you should only need to use material with fixed vapour resistances in conden-
sation risk calculations. A fixed vapour resistance material requires the following information:

Type: select Fixed vapour resistance.

Description : type a description of the layer -- this will appear on the print out.

Thickness: enter in millimetres.

Thermal conductivity: enter in W/mK.

The program calculates the Thermal resistance in m?K/W .

Vapour resistance: enter in MNs/g.

4.4.2.4 Membranes

Membranes, such as vapour control layers or breather membranes, are treated as having no
thermal resistance and have no effect on U-value calculations: they only affect condensation
risk analysis. Membranes require the following information:

» Type: select Membrane.

= Description : type a description of the layer -- this will appear on the print out.

* Vapour resistance: enter in MNs/g.

4.4.2.5 Clear cavities

The thermal resistance of a cavity is not calculated from its thickness, although it is affected by
the direction of heat flow within the construction. Standard values for cavities may be found
in the Products Database and in publications such as BS 5250. Clear cavities, such as those
in cavity walls, require the following information.

= Type: select Clear cavity.

Description : type a description of the layer -- this will appear on the print out.

Thickness: enter in millimetres.

Thermal resistance: enter in m2K/W.

» Vapour resistance: cavities have a vapour resistance of 0 MNs/g.
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4.4.2.6 Bridged cavities

Bridged cavities, such as those in some timber framed constructions, are treated the same as

clear cavities, but with bridging details added (see fubsection 4.4-3)). Bridged cavities require
the following information.

Type: select Bridged cavity.
= Description : type a description of the layer -- this will appear on the print out.

Thickness: enter in millimetres.

Thermal resistance: enter in m2K/W .

= Vapour resistance: cavities have a vapour resistance of 0 MNs/g.

You will also need to enter the bridging details (see fubsection 4.4.3).

4.4.2.7 Vented cavities

Vented cavities, such as the batten space in a warm pitched roof, are treated the same as clear
cavities. Identifying a cavity as vented allows some layers of the construction to be ignored
for condensation risk analysis (for further information see section fubsection 6.7.3)). Vented
cavities require the following information:

* Type: select Vented cavity.

Description : type a description of the layer -- this will appear on the print out.

Thickness: enter in millimetres.

Thermal resistance: enter in m2K/W.

» Vapour resistance: cavities have a vapour resistance of 0 MNs/g.

4.4.2.8 Thermal insulation

In order to comply with the requirements of European product standards for factory manufac-
tured thermal insulation (standards BS EN 13162 to BS EN 13172) JPA Designer rounds the
thermal resistance values for thermal insulation down to the nearest 0.05 m?K/W. To ensure
the program does this correctly you must tick the is thermal insulation box for all layers of
factory manufactured thermal insulation. The original value for thermal resistance will appear
in the Edit material dialogue box while the U-value window will show the rounded value. For
additional information on the rounding feature and instructions on how to turn it on or off see

section fubsection 6.7.3).
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4.4.3 Thermal bridging

Thermal bridges are formed where the material in a layer is interrupted by a second material
with different thermal conductivity, for example, the insulation in a timber framed wall is
interrupted (bridged) by the timber studs. In most cases thermal bridging increases heat loss
through the bridged layer (hence the commonly used term “cold bridge').The effect of thermal
bridges which occurring regularly throughout a layer (repeating thermal bridges) has to be
included in U-value calculations by added the details of the thermal bridge to each bridged
layer using the Edit material dialogue.

Thermal bridging is either:

= one-dimensional e.g. timbers running in one direction; or,

= two-dimensional e.g. mortar joints which run vertically and vertically.
The information required for setting thermal bridging includes:

= The thermal conductivity of the bridging material: for common bridge materials this can
be set along with the Bridge description.

e The width of the bridging material (Bridge width) and horizontal distance between
bridges (Non-bridge width). For two-dimensional bridging you will also need to know
the vertical distances between bridges (Non-bridge height). The software uses those
values to determine the Proportion bridged.

However, for some constructions you will need to adjust the Proportion bridged to
allow for additional bridging material such as cross noggins and other framing in timber
framed walls. You can find recommended standard proportions in the BRE publication
BR 443 Conventions for U-value calculations.

» The thickness of the bridging material. In virtually all cases the bridge thickness will be
the same as that of the main material of the layer.

To enter thermal bridging details:

1. Use the Bridge type radio buttons to determine whether the bridging is 7 dimensional
or 2 dimensional. The Edit material dialogue now shows the Thermal bridge section.

If you are not sure whether the bridging is one or two dimensional clicking the Help
button will open a guidance window: the annotation on the help diagrams match those
on the data entry boxes.

2. Select the bridging material from the Bridge description drop-down. The program sets
the Bridge thermal conductivity.

If you are using an unusual bridging material you can enter your own description, then
enter the conductivity manually.

3. Enter the Bridge width in mm.

4. Enter the Non-bridge width in mm.
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. For two-dimensional bridging enter the Non-bridge height in mm.

If necessary, change the Proportion bridged value to a standard value. The software
adjusts the Bridge width accordingly.

. Set the bridge thickness by selecting Follows material thickness, or selecting Fixed at

then entering thickness in mm.

In some constructions -- notably built up metal roof and wall cladding -- there are two sets of
thermal bridges.
To enter details of a second bridge:

1.
2.
3.

4.5

Enter the details for the first bridge.
Click the Second bridge box. The Optional second bridge section is displayed.

Select the bridging material from the Bridge description drop-down. The program sets
the Bridge thermal conductivity.

If you are using an unusual bridging material you can enter your own description, then
enter the conductivity manually.

. Enter the Bridge width in mm. The software uses the Non-bridge width for the first

bridge to calculate the Proportion bridged.

. Enter the Non-bridge width in mm.

When the bridging material is air you can use the Small airspace resistance button to
calculate the thermal resistance of the bridge: enter the thickness of the airspace and its
width -- both in mm -- then click OK. The resistance is displayed in the Bridge thermal
resistance box.

Correction factors

Whilst the U-value of an element depends largely upon the thermal properties of the layers
of which it is composed there are a number of other factors which can affect the rate of heat
loss. Those are addressed by applying correction factors to the calculation.

There are correction factors for:

Mechanical fasteners which penetrate insulation, dUf (see fubsection 4.5.1));

Air gaps in insulation layers, dUg (see pubsection 4.5.2).

The effect of rainwater cooling on inverted roofs, dUr (see fubsection 4.5.3

Brackets in rainscreen cladding systems, dUxx (see fubsection 4.5.4).

Insulation compression in built up metal roofing and cladding, dUp (see fubsection 4.7.2).

The correction factors are calculated separately from thermal resistances of the layers, and are
then added to the raw U-value: however, if the correction factors total less than 3% of the
raw U-value then they are ignored in the calculation. The values for correction factors are
displayed in the main U-value window, next to the final U-value.

It is also possible to adjust the result of a U-value calculation to account for the effect of having

an unheated space to the cold side of the construction (see pubsection 4.5.5).
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Figure 4.5: Data entry boxes for the mechanical fasteners correction
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4.5.1 Mechanical fasteners

Metal fasteners which penetrate layers of thermal insulation reduce the effectiveness of the
insulation: that effect has to be included in U-value calculations, using the correction factor
dUf. Common constructions which require the correction are:

= Cavity walls with partial or full-fill cavity insulation.

= Warm pitched roofs where insulation is laid over the rafters and restrained by counter-
battens fixed back to the rafters.

= Warm flat roofs where the insulation and/or the waterproof membrane is mechanically
fixed to the deck.

There is no need to apply a correction:

= to constructions without fasteners, e.g. solid masonry walls;

for fasteners with both ends in contact with metal sheets;

for wall ties across an empty cavity;

for wall ties between a masonry leaf and timber studs;

where the thermal conductivity of the fastener, or part of it, is less than TW/mK.

The correction factor dUf is calculated from:

The alpha coefficient which represents the direction of heat flow. Standard values are
6 for wall ties between masonry leaves, 5 for roof fixings and 1.6 for steel framed walls.

The thermal conductivity of the fastener: typically 17 W/m?2K for stainless steel and
50 W/m2K for mild steel.

The number of fasteners per square metre.

The cross sectional area of the fastener: typical double triangle ties have a cross sec-
tional area of 11.3 mm~™2 (based on 3.8 mm diameter).

To enter data for mechanical fasteners:
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Figure 4.6: Selecting values for common configurations
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Figure 4.7: Correcting for air gaps in insulation layers
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1. From the menu bar select Edit=Construction type. The U-value Construction dialogue
opens.

2. In the Correction for mechanical fasteners section either use the drop-down to select
one of the standard fastener types (see or enter the individual items of data
for the fasteners.

To view the default values click the Help button.
3. If the calculation is for a light steel frame construction you must indicated which layer is

bridged by the fasteners using the drop down box which is displayed if you select steel
frame construction.

4.5.2 Air gap correction

Air movement through and around an insulation layer can reduce its thermal performance.
To allow for that the U-value calculation should include a correction factor, dUg, which is
calculated by the software on the basis of the amount of air movement possible, as represented
by the coefficient dU"':

= Where no air gaps penetrate the insulation layer and no air circulation is possible on its
warm side, dU" = 0.00 W/m?K.

= Where some air gaps penetrate the insulation layer and no air circulation is possible on
its warm side, dU'" =0.01 W/m?K.

* Where some air gaps penetrate the insulation layer and some air circulation is possible
on its warm side, dU" = 0.04 W/m2K.

A value for dU" must be set for every insulation layer.

To correct for air gaps:
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1. In the main U-value window double click on the insulation layer. The Edit material
dialogue opens.

2. Enter the appropriate value for dU" in the dU" box (see Figure 4.7). then click OK.

Click the Help button to view the standard values for dU". In many cases the default
value of zero is appropriate.

4.5.3 Rainwater cooling

Inverted roofs -- or protected membrane roofs -- have some or all of the thermal insulation
installed over the top of the waterproof membrane where it is restrained by aggregate or other
ballast. Rainwater falling on inverted roofs can percolate between insulation boards to the
waterproofing membrane, where it will increase the rate of heat loss. The reduction in perfor-
mance is represented within a U-value calculation by the rainwater cooling correction factor,
dUr, which is calculated from:

= The average rate of rainfall during the heating season, p (mm/day);

= A drainage factor, f, which represents the fraction of p which reaches the waterproofing
membrane;

= Afactor, x (W.day/m2Kmm), for increased heat loss caused by rainwater flowing on the

membrane.

In JPA Designer that data is entered using the U-value Construction dialogue. As you have to
indicate which layer is affected by the rainwater cooling it is best to add the correction factor
after you have defined the layers in the construction.

To enter rainwater cooling data:

1. From the menu bar select Edit=Construction Type.

2. In the Element type section select Flat roof.

3. Tick the Inverted roof box. New data entry boxes appear.

4. Use the XPS layer drop-down to indicate which layer is affected by the rainwater cooling.

5. Enter values for f.x and p. Click OK.

If you do not have project-specific values you can use the default values for f.x and p.



CHAPTER 4. U-VALUE CALCULATIONS 31

Figure 4.8: Data for rainscreen cladding correction
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4.5.4 Rainscreen cladding

When calculating U-values for walls which include rainscreen cladding the results have to
be adjusted to account for the effect of any metal fixings which penetrate the insulation. JPA
Designer can correct for the effect of point fixings, using method (c) in section 4.9.5 of BR
443 Conventions for U-value calculations.

The calculation requires the point thermal transmittance of the fixing, x, and the number of
fixings per square metre, n. As x depends on the type of fixing you must get the correct value
from the fixing manufacturer. The data is entered in the U-value Construction dialogue.

To correct for brackets in rainscreen cladding:

1. From the menu bar select Edit>Construction Type. The U-value Construction dialogue
opens.

2. In the Element type section select Wall.
3. Tick the Rainscreen cladding box. New data entry boxes appear (see Figure 4.9).

4. Enter values for x and n. Click OK.

If you do not have project-specific values you can carry out an initial calculation using
the default values for x and n.

4.5.5 Elements separating heated and unheated spaces

The rate of heat loss through an element which separates a heated space from an unheated
space will be lower than that through an identical element which separates a heated space
from outside, as the relatively warm air within an unheated space acts as a thermal buffer.
The combined method for calculating U-values allows for this effect using the ratio of:

« the surface areas of the elements which separate the heated space from the unheated
space, Ai, to,

= the surface areas of the elements which separate the unheated space from outside, Ae.

When measuring Ai and Ae, you should include walls and intermediate floors (such as that
over an integral garage) but exclude ground floors. Ai and Ae are measured in m?. For further
information see ISO 6946 section 5.4.

To allow for unheated spaces:

1. From the menu bar select Edit>=Construction type. The U-value Construction dialogue
opens.

2. Enter the two areas in the Ai and Ae boxes (see Figure 4.9).
3. Click OK.
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Figure 4.9: Data entry for elements separating heated and unheated spaces
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Figure 4.10: U-value calculation with a variable layer
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4.6 Using variable layers

32

The variable layer feature of JPA Designer helps you assess the effect of using different materials
in the same place within an element; for example, by using a variable layer you could compare

the effect of different insulants on the U-value of a cavity wall.

A calculation with a variable layer has a place-holder layer in the main window, and has the
additional Variable layer pane which accepts a number of different layers. Each of those layers
shows the results of the U-value calculation as if that layer replaced the place-holder layer in

the main calculation.
To use a variable layer:

1. In the main U-value window click the layer below the position for the variable layer.

2. From the menu bar select Insert>Variable layer. The program inserts a variable layer in

the calculation and displays the Variable layer pane (see Figure 4.10).

3. Select the blank layer in the variable layer pane and add layers from the database, or by

add and edit blank layers.

When using the database, you must be ensure the contents of variable layer pane are

showing in the Construction box of the Products Database dialogue.

The U-values for the constructions with the variable layer are shown alongside the variable
layer materials: no U-value appears in the status bar. You can only have one variable layer in

a calculation.
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4.7 Complex calculations

4.7.1 Light steel framed structure

There are three different forms of light steel-framed structures:

* Warm frame constructions: all the insulation is outside the steel framing.

e Hybrid constructions: some insulation is fitted between the steel studs and additional
insulation placed on the outside of the studs to reduce thermal bridging through the
steel.

e Cold frame constructions: all of the insulation is included within the thickness of the
steel components and is bridged by it.

The high thermal conductivity of steel means the combined method must be modified for
elements where some or all of the insulation is bridged by light steel framing. JPA Designer
uses the modified calculation method which was published in BRE Digest 465. U-values for
light steel-frame construction.

The procedure for calculating the U-value of a light steel-framed element using JPA Designer
is the same as for any other element, but with the following modifications:

1. Identify the element as light steel-framed and enter the framing details.

In the Uvalue Construction dialogue use the light steel-frame radio buttons to define is
as warm or cold/hybrid.

If you select Cold/Hybrid enter the stud spacing, stud depth and flange width. Use the
offered default values if you do not know the stud depth and spacing.
2. Enter the layers of the construction in the main Uvalue window.

For cold/hybrid elements some of the layers will be bridged (see pubsection 4.4.3) for
guidance on entering bridged layers):

In warm elements the air space between the studs should be entered as a bridged cavity,
with steel as the bridging material.

In cold/hybrid elements the insulation layer will be bridged by steel.

Any airspace behind the insulation and between the studs should be entered as a bridged
cavity.

Do not include the flanges of the steel studs when entering bridging details.

3. Enter corrections for any mechanical fasteners which penetrate the insulation by com-
pleting the Correction for mechanical fasteners section in the Uvalue Construction

dialogue (see FubseCtion 4.5:1).

Use the first drop box to indicate which layer is bridged by the mechanical fasteners,
then enter the fasteners' dimensions and spacing. The alpha coefficient is 0.8 for warm
constructions and 1.6 for cold/hybrid constructions.
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Figure 4.11: Built-up metal wall or roof cladding
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Figure 4.12: The Small Airspace Resistance Calculator
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4.7.2 Twin skin metal cladding and roofing

The extent of the thermal bridging in twin-skin metal roofing and cladding systems formed
with rails and brackets means the combined method has to be modified. JPA Designer uses
the method described in the Steel Construction Institute research paper P312: that method
takes account of:

= The bridging effects of the rail and the air spaces around the rail.

= The point bridging produced by the brackets.

» The compression of the insulation by a shallow-profiled liner (profile depth less than 25

mm).

To calculate U-values for twin-skin metal roofing and cladding:

1. Create and open a new U-value calculation.
2. Enter any project information.

3. In the U-value Construction dialogue select either wall or flat roof and tick the Built up
metal roof/wall box: the program will display several new data entry boxes. Do not
complete them at this stage. Click OK.
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4.

10.

11.

12.

13.

14.

Enter the layers in the construction in the main U-value window. Enter the insulation
in two layers: the first layer being the insulation which is bridged by the rails and the
second that which is penetrated only by the brackets.

For example, a 170 mm layer of insulation in a construction with 40 mm deep rails should
be divided into one layer 40 mm thick and one layer 130 mm thick. You will find later
parts of the calculation easier if you give the two layers distinctive names.

. Enter the bridging details for the layer of insulation bridged by the rails (see

for details). In the Edit Materials dialogue select one dimensional bridging to
show the thermal bridging details. Enter the details of the rails: bridge material -- steel
studs, bridge width, non-bridge width. The software sets the bridge thermal conduc-
tivity. The program will show the proportion bridged and the thermal resistance of the
bridge.

For °L' shaped sections the bridge width will usually be the thickness of the steel, but for
'C' and "U' sections, where the rail penetrates the insulation layer twice, use double the
thickness of the steel as the bridge width.

Enter the bridge details for the air spaces caused by the rail. Tick the Second bridge box.
The Optional second bridge section is displayed.

. Enter the bridge material (air) and bridge width (in mm): use twice the rail width to

allow for the compression of the insulation around the rails. The program calculates the
proportion bridged using the data from the first bridge.

To calculate the thermal resistance of the air space click the Small airspace resistance
button. The Small Airspace Resistance Calculator dialogue opens (see Figure 4.12).

. Enter the thickness and width of the air space. The thickness will be the same as the

rail depth. The width should be twice the rail thickness. Click OK to close the dialogue
transfer the results to the bridging calculation.

Enter the air gap correction, dU", for both insulation layers (see fubsection 4.5.2): use
the value 0.01. Click OK.

From the menu bar select Edit=Construction Type. The Uvalue Construction dialogue
opens.

In the Built-up metal roof/wall cladding section enter the Rail spacing and Rail width
(see Figure 4.T1). Use the drop-down to indicate which layer is bridged by the rail liner

details.

If the liner profile compresses the insulation and the depth of the profile is 25 mm or
less tick the box Insulation is compressed by inner or outer sheet. Four new data boxes
appear.

Enter the Sheet profile width, Sheet profile depth and Sheet profile centres in mm. In
the drop box select the layer of insulation which is not bridged by the rails.

If the liner profile is deeper than 25 mm ignore the check box and change the thickness
of the insulation layer by subtracting the profile depth from the original thickness (e.g.
for a 30 mm profile with 130 mm actual depth of insulation use a value of 130 -- 30 =
100 mm).
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Figure 4.13: Inputting data for rainwater correction
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15. Enter the details for the brackets in the Correction for mechanical fasteners section.
Enter the thermal conductivity of the brackets (usually 60 W/mK for steel), the number
of brackets per square metre (calculated by dividing the total number of brackets by the
total element area) and the cross sectional area of the brackets (measured at the thickest
point). The value of alpha, 1.6, is the default setting for these constructions. Finally, use
the drop-down to select the layer which is bridged by the brackets. Click OK.

4.7.3 Inverted roofs

In inverted roofs (often known as protected membrane roofs) some or all of the thermal insu-
lation is applied above the waterproof membrane and restrained by aggregate or other ballast.
Rainwater falling on the roof can percolate to the waterproofing membrane and increase the
rate of heat loss. To allow for this effect a rainwater cooling correction factor, dUr, has to
be applied to inverted roof calculations ( the rainwater cooling factor is described in
fion 4.5.3). Because you have to indicate which layer is affected by the rainwater cooling it is
best to add the correction factor after you have defined the layers in the construction.

To enter an inverted roof:

1. From the file menu select Edit=Construction type. The U-value Construction dialogue
opens.

2. In Element type select Flat roof. Insert an Element description then click OK.

3. Add the layers of the construction (see fection 4.3).

4. Open the U-value construction dialogue again and in Element Type tick the Inverted

box. The dialogue shows three data boxes (see Figure 4.13).

5. Enter the values for f.x and p and in the drop-down select the layer of extruded polystyrene
insulation (XPS). Click OK.

XPS is virtually the only insulation material suitable for inverted roofs.

4.8 Ground floor U-values

As the combined method deals with heat loss from air to air, through an element, it has to be
modified for ground floors to include the thermal resistance of the ground itself. JPA Designer
calculates U-values for ground floors using the method is set out in ISO 13370".

This section describes the general procedure for calculating the ground floor U-value, whilst
the following sections describe the individual parts of the calculation.

To calculate a ground floor U-value:

Do not use this method to calculate U-values of floors over open or unheated spaces such as car parks or garages;
instead select floors other than ground floors in the Construction dialogue box and proceed as usual.
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1. Create a new U-value calculation in the Project Manager window and open it for editing

(see fection 3-9).

2. Enter any project information in the Project Information dialogue.

3. In the U-value Construction dialogue select Solid ground floor orSuspended ground
floor, enter a description for the construction, then click OK. The Ground Floor Details
dialogue opens.

4. Enter the data for the ground (see pubsection 4.8.1)). Click OK.

5. Add the remaining layers of the floor construction.
Include layers to represent:

» Screed;
e Insulation;

 Flooring, such as particle board.
Omit any layers which consist of:

= Hardcore beneath a groundbearing slab.
= Groundbearing concrete slabs with density greater than 1800 kg/m?®.

= Thin floor coverings such as vinyl or carpet.

For further guidance refer to the BR 443 Conventions for U-value calculations.

4.8.1 Ground floor details

The Ground Floor Details dialogue contains the data which describes the ground and the
floor structure (see Figure 4.T4).

It has five sections:

Floor type. The choice of floor type will determine how other parts of the dialogue
appear.

Floor dimensions.

Deck.

Suspended ground floor details.

Edge insulation.
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Figure 4.14: The Ground Floor Details Dialogue
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4.8.1.1 Floor type

There are three types of ground floor:

 Solid: a floor which bears directly on the ground with no void between the floor structure
and the ground, for example, a ground-bearing concrete slab;

= Suspended block and beam: with a void between the floor deck and the ground, with the
deck formed from pre-cast concrete beams infilled with concrete blocks or proprietary
insulating units,.

» Suspended: a floor with a void between the floor structure and the ground, with a timber
deck supported on timber joists.

Use the Floor Type radio buttons to select the type of floor construction.

4.8.1.2 Floor dimensions

The thermal resistance of the ground is determined from the ratio of the floor's perimeter and
area. The perimeter (expressed in metres) is measured along the finished internal surfaces
of exposed and semiexposed walls. The area (expressed in square metres, m?) is measured
between the finished internal wall surfaces. Unheated spaces outside the insulated fabric
should be excluded when calculating the perimeter and area.

If you are calculating the ground floor U-value for flats in a block or for a house in a terrace
you can use the perimeter and area for the whole block or terrace instead of the dimensions
of the individual occupancies.

To enter the Floor dimensions:
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Figure 4.15: Calculating the resistance of a beam and block deck
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« If you have calculated the Perimeter/Area ratio you can enter it directly in the P/A box.

= Alternatively, tick the Calculate it box and enter the values in the Perimeter and Area
boxes for you to fill in.

4.8.1.3 Deck

The data required for this section depends upon the type of construction specified in the Floor
Type section of the Ground Floor Details dialogue.

« Solid floor: no deck data required.

» Suspended block and beam floor: the program offers a default thermal resistance for
the deck of 0.2 m?K/W. Alternatively, the program can also calculate the resistance
using the specific details for your floor if you tick the Calculate box (see Figure 4.T5)
then input data for:

* The blocks: Width, Thickness and Conductivity.
e The beams: Web width and Beam conductivity.
* The screed: Screed depth and Screed conductivity.

e Suspended floor: the program offers a default thermal resistance for the deck of 0.2
m?K/W for the deck. This represents a 18 mm softwood deck. Insulation between
joists should be entered as a separate layer, bridged by timber in one dimension, (see

Eubsection 4.4.3).

4.8.1.4 Suspended ground floor details

In a suspended ground floor, whether beam and block or timber, there will be some heat loss
through the walls of the sub-floor void, both by conduction and also by air movement. JPA
Designer calculates that heat loss using the data in Suspended Ground Floor Details section
of the Ground Floor Details dialogue. The values required are:
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« [E - the area of ventilation openings per perimeter length of under floor space, in m?/m;
* H - the height of the upper surface of the floor above external ground level, in m;

e Uw - the Uvalue of the walls of the under floor space above ground level, calculated
according to 1SO 6946, in W/m¥K (you can do this as a separate calculation using JPA
Designer);

* Fw - the wind shield factor, see [fable 2.
e V- the average wind speed at 10m above ground level, in m/s
e Lambda - the conductivity factor for the type of ground: use 1.5 for clay or silt, 2.0 for

sand or gravel and 3.5 for homogeneous rock.

Where some or all of these details are unknown you should use the default values. If you edit
the values then want revert to using the defaults click the Default button.

Table 4.2: Windshield factor

Location  Example Fw

Sheltered  City centre  0.02
Average  Suburban  0.05
Exposed  Rural 0.10

4.8.1.5 Edge insulation

Installing insulation horizontally around the perimeter of the floor -- edge insulation -- will
reduce thermal bridging at the perimeter and improve the floor's overall thermal performance.
Edge insulation can be:

e Horizontal: insulation installed around the perimeter of the floor in the same plane as
the floor?.
= Vertical: insulation installed at the perimeter of the floor, at right angles to the plane of

the floor.

Use the radio buttons to select the type of edge insulation present, then enter the details of
the insulation (if there is no edge insulation leave the rest of this section blank).

« Internal and external surface resistances use the default values of 0.140 m2K/W and
0.040 m?K/W.

< Insulation thickness: board thickness, in mm.

2Horizontal edge insulation was commonly used to reduce thermal bridging and cold spots on larger floors
which did not require a complete layer of thermal insulation. However, the lower U-values now required by Building
Regulations usually require a full layer of insulation, making the use of horizontal edge insulation unlikely.
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Figure 4.16: Entering data for basement floors
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Insulation conductivity: the lambda value, in W/mK.

Insulation name.

Insulation width or depth (depending upon whether the insulation is laid horizontally
or vertically): the board width, in mm.

= Description: optional description of the insulation.

You can also use the Products Database to enter details of the insulation by clicking on the
button by the Insulation name box.

Further information on edge insulation may be found in BRE Information Paper 7/93.

4.9 Basement U-values

The methods for calculating U-values of basements are set out in BS EN 1SO 13370. The
calculations for basement floors and walls are linked, with each calculation requiring data
about the other element. Because of this it is easier to calculate the basement floor U-value
first, followed by the basement wall U-value. For a full explanation of the calculation methods
consult BS EN ISO 13370.

4.9.1 Basement floors

To complete a basement floor U-value calculation you will need to know:

The floor's Perimeter/Area ratio: P/A;

The thickness of the basement walls: w (metres);

= The average depth from the external ground surface to the basement floor: h (metres);

The thermal conductivity of the ground: lambda (W/mK) (see and annex G
of BS EN 1SO 13370).

To calculate a basement floor U-value:

1. Create a new U-value calculation in the Project Manager window and open it for edit-
ing.
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. In the U-value Construction dialogue set the Element Type to Basement Floor, enter

an Element description then click OK. The Ground Floor Details dialogue opens (see

o 1.76).

. Enter the Perimeter/Area ratio, P/A, or check the box labelled “calculate it' and enter the

Perimeter and Area separately.

Enter the wall thickness, w, the basement depth, h, and the thermal conductivity of the
ground, lambda. Click OK.

. Enter the layers which make up the floor construction.

Include layers to represent:

« Screed;

e Insulation;

» Flooring, such as particle board.

Omit any layers which consist of:

» Hardcore beneath a groundbearing slab.

= Groundbearing concrete slabs with density greater than 1800 kg/m?®.

 Thin floor coverings such as vinyl or carpet.

Table 4.3: Thermal conductivity of the ground

Category  Description Thermal conductivity, (W/mK)
1 clay or silt 1.5

sand or gravel 2.0
3 homogeneous rock 3.5

4.9.2 Basement walls

To complete a basement wall U-value calculation you will need to know:

The floor's Perimeter/Area ratio: P/A;

The thickness of the basement walls: w (metres);

The average depth from the external ground surface to the basement floor: h (metres);
Details of the insulation in the basement floor.

The thermal conductivity of the ground: lambda (W/mK) (see and annex G of
BS EN ISO 13370).
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Figure 4.17: Entering data for basement walls
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To calculate a basement wall U-value:

1. Create a new U-value calculation in the Project Manager window and open it for edit-
ing.

2. In the U-value Construction dialogue set the Element Type to Basement Wall, enter
an Element description then click OK. The Ground Floor Details dialogue opens (see

gure 4.17).
3. Enter the Perimeter/Area ratio, P/A, or check the box labelled “calculate it' and enter the

Perimeter and Area separately.

4. Enter the wall thickness, w, the basement depth, h, and the thermal conductivity of the
ground, lambda.

5. Enter the details of insulation in the basement floor. Either enter the name, thickness
and conductivity of the insulation, or use the database button to select the insulation
from the Products Database. Click OK.

6. Now add the layers of the construction in the main U-value window.

4.10 Outputting results

You can print the results of U-value calculations onto paper or produce a PDF file which can
be opened on any computer with the free Adobe Reader software installed; PDF files are ideal
for emailing to people who need to see the results of the calculation but do not have JPA
Designer. For both print and PDF the output includes:
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Figure 4.18: Sections To Print dialogue
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Figure 4.19: Print preview controls
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» Project information;
« Details of the construction;

» The U-value and any correction factors.
To print results:

1. Select File=Print from the menu bar (or click the Print button on the tool bar). The
Sections To Print dialogue opens (see (Fig T.T13).

2. Use the tick boxes to select whether to print an additional page showing the details
of the bridging calculations (you can also choose whether to include the ISO moisture
table for condensation analysis).

3. Click OK. The Print preview window opens.

4. Use the buttons on the tool bar to view successive pages of the print out, then click the

Print button to print the pages (see Figure 4.T9).

To create a PDF file of the results:
1. From the menu bar select File=Create PDF. A dialogue asks if you want to open the
PDF when it is created.
2. Select Yes or No. The Sections To Print dialogue opens (see Figure 4.19).

3. Use the tick boxes to select whether to print an additional page showing the details
of the bridging calculations (you can also choose whether to include the ISO moisture
table for condensation analysis).
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4. Click OK. The Print preview window opens (see Figure 4.19).

5. Use the buttons on the tool bar to view successive pages of the print out, then click the
Print button to print the pages. The program will then create a PDF file of the calculation.

*The name of the PDF file will include the JPA Designer file name and the calculation
name, so the calculation tile hung wall in a project The Meadows will be called The
Meadows.]DPtile hung wall.PDF. The file will be saved into the JPA Designer program
folder or in the start-up folder you have specified.

Note: as Windows does not allow certain characters to be used in file names you should
ensure the calculation names in JPA Designer do not contain those characters, otherwise
PDF creation will fail. The restricted characters are /\: *? <> |.

You can change the printer settings by selecting File=Printer setup from the menu bar.

4.11 Calculation options

The European standards for factory produced thermal insulation products® set out the require-
ments for determining and quoting the thermal performance of thermal insulation. For each
product:

the value of thermal resistance, R90/90, shall be ... rounded downwards to the
nearest 0,05 M?K/W, and declared as RD in levels with steps of 0,05 m?K/W.

To comply with that requirement JPA Designer rounds down the thermal resistance of all
layers which are marked at thermal insulation. To mark a layer as thermal insulation tick the
is thermal insulation box in the Edit material dialogue.

Because there may be occasions when you need to carry out calculations without rounding
the feature may be turned off and on. By default, rounding is on: this is indicated by red text
in the bottom margin of the U-value window.

To change the rounding setting: 1. From the menu bar select Options. The Calculations

Options dialogue opens (see Figure 4.20).

1. Tick the Round down thermal resistance box to toggle rounding on or off.

2. Click OK to accept the change.

3The series runs from BS EN 13162:2001 Thermal insulation products for buildings. Factory made mineral wool
(MW) products. Specification to BS EN 13172:2001 Thermal insulating products. Evaluation of conformity. There is
one standard for each major thermal insulation material.
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Figure 4.20: Calculation Options dialogue
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4.12 Editing the Products database

To make U-value calculations easier all JPA Designer U-value modules include the Products
database, providing you with the key data on generic construction materials, cavities and
branded products from a number of manufacturers. This section explains how you can add
frequently used products to the database.

The materials within the database are organised into three categories:

= Branded products from manufacturers, shown in bold in the categories list;

= Generic materials, shown in normal type in the categories list;

= User defined materials, shown in italics in the categories list.
You can use all three types of material in Uvalue calculations and you can create, edit and
delete user defined categories and materials. However, you can not edit or delete branded
or generic categories or materials. To change the values of branded or generic materials you

must work on a duplicate (clone) of the category or material. Cloning a category creates a
new category containing the same materials as the original.

To make changes to the Products database you must first open the Edit database dialogue
(Figure #.71) by selecting Edit>Database from the main menu.

To add a user defined category:

1. Click the New category button.
2. Enter the name of the category in the New category dialogue.

3. Click OK. The new category is created.
To rename an existing category:

1. Select a category by clicking on it.
2. Click the Edit category button. The Edit category dialogue opens.

3. Enter a new name then click OK. The category is renamed.
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Figure 4.21: The Edit Database dialogue
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To clone a category:

N —

To delete a category:

. Select the category to delete.

. Select the category to clone by clicking on it.
. Click the Clone category button. The Clone category dialogue opens.
. Enter a name for the new category and click OK.

. A new category will be created, containing copies of the original materials.

. Click Yes to delete the category, No to keep it.

To insert a new material (only in user categories):

. Select the category in which you want to create the new material.
. Click the New product button. The Edit material dialogue opens.

. Complete the Edit material dialogue (see fection 4.4).
Click OK. The new product is added to the category.

47

. Click the Delete category button. An Information dialogue asks you to confirm the
deletion.
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Figure 4.22: The Search Database dialogue
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To edit an existing user defined material:

4.

. Select the product you wish to edit.
. Click the Edit product button. The Edit material dialogue opens.
. Make the changes in the Edit material dialogue (see fection 4.4).

Click OK. The product information is updated.

To clone an existing product:

1.

2.

Select the product and click the Clone product button. A copy of the product will be
inserted in the category.

Click on the clone to edit it.

To delete a product (only in user categories):

1.
2.

Select the product you wish to delete.

Click the Delete product button. The product is deleted.

You can search the database to find specific products:

1.
2.

5.
6.

Click the Search button. The Search Database dialogue opens (see Figure 4.22).

In the Search Database dialogue enter the text you want to search for and the direction
the program should search through the database (forwards or backwards).

. Tick the Ignore case box if you want the search to ignore capitals and lower-case letters.

Click Find first to start the search. The program will display the first matching product
in the Products pane.

Click Find next to go on to the next matching product.

When you have found the product you want click Close to close the Search dialogue.

When you have finished working on the database, click the Close button to return to the main
U-value window.
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4.12.1 Short codes

You can assign codes to user defined materials as you enter them in the database. The short
codes can then be used for rapid data entry using the Products database (see fubsection 4.3.1).
You can also use short codes to determine the order in which products and materials are
presented within categories, to speed up data entry for common constructions.

To sort the database by short codes you must first assign short codes to the materials; use a
numbering system which matches the order in which you want the materials to appear. Once
you have assigned short codes you should click on the Sort on short code tick box in the

Products database dialogue (see Figure 4.2).



5  Condensation risk analysis

The Uvalue Professional module calculates the risk of interstitial condensation forming at the
interfaces of layers within an element.The module, which follows the recommendations of BS
5250 uses the method of analysis set out in BS EN 1SO 137882.

For each interface within a building element the module determines:

= the amount of condensation or evaporation during each month;

e the maximum amount of moisture deposited;

» the accumulated mass of water compared to total evaporation during the year;
 the annual moisture balance.

The program can still perform analyses to the BS 5250:1989 method?®. For information on
using this method see of this manual.

The likelihood of condensation forming within a building element depends upon the hy-
grothermal properties of the materials (thermal conductivity or resistance and vapour resis-
tivities or resistance) and the environmental conditions (internal and external temperatures
and relative humidities).

Most of the information used by JPA Designer for calculating condensation risk is also used
in the main body of the program for calculating U-values. The only additional information
required is the vapour resistivity/resistance data for materials, and the environmental data for
the building and site.

To carry out condensation risk analysis:

1. Build up an element in the same way as you would for a Uvalue calculation.

2. Ensure vapour resistance properties have been defined for each layer (use the Edit ma-
terials dialogue to make any changes).

3. Set the environmental conditions (see pection 5.1));
4. View the results (see fection 5.7).

Please note the module can not carry out condensation risk analysis for ground floors, base-
ments nor constructions containing variable layers; neither will it calculate the risk of surface
condensation.

BS 5250:2002 Code of practice for control of condensation in buildings.

2BS EN ISO 13788:2002 Hygrothermal performance of building components and building elements -- Internal
surface temperature to avoid critical surface humidity and interstitial condensation -- Calculation methods.

3The BS 5250:1989 Appendix D method is based on the same underlying principles as the method set out in
I1SO 13788, but (i) analyses condensation risk for a 60 period rather than the whole year and (ii) reports results in a
different way.

50
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5.1

Environmental conditions

The condensation risk calculation requires mean monthly data for:

 Internal temperature (Int T); the design temperature inside the building, in degrees

Celsius. The default for analysis is to use the same internal temperature throughout the
year. If no project temperature has been specified use 20°C as a default value for a UK
building.

Internal relative humidity (Int RH); this is largely determined by the type of activity
which will take place within the building. ISO 13788 defines five occupancy types with
different humidity characteristics: BS 5250:2002 suggests relative humidity ranges for
those types, see [fable 5.1 The internal relative humidity is affected by the external
conditions.

External Temperature (Ext T) and External Relative Humidity (Ext RH); the external
conditions depend upon the building's location. JPA Designer includes external tem-
perature and humidity data from 20 sites around the UK, allowing you to select the
nearest location to the project site 4. For a “worst case' scenario select Eskdalemuir.

The data is entered using the Environmental conditions dialogue, which allows you to enter
data for analysis using ISO 13788 or BS 5250:1989. The default calculation method is ISO
13788 (to use the previous BS 5250:1989 calculation method see pection 5.3).

To set the environmental conditions:

1.

5.2

From the menu bar select Edit=Environmental conditions. The Environmental condi-
tions dialogue opens.

. Select the humidity class using the Internal humidity class dropdown. The Int RH col-

umn is completed.

. Enter the internal design temperature in the Internal temperature box. The Int T column

displays the values. If you wish to vary the internal temperature throughout the year you
can type values directly into the Int T column for each month.

From the Building location dropdown select the location of the building. The Ext T and
Ext RH columns are completed and the values in the Int RH column adjusted. If you
have site specific data you can type values directly into the table.

Click OK to accept the data and close the dialogue.

Viewing results

JPA Designer presents the results of condensation risk analysis in three formats:

* As month by month data, in the ISO Condensation Table.

e In summary form, in the Results table.

= As a graph, in the Dewpoint graph.

4The data is taken from Meteorological data 1961 --1990 published by the World Meteorological Office.



CHAPTER 5. CONDENSATION RISK ANALYSIS 52

Table 5.1: Internal relative humidity classes

Relative humidity (%)

Class  Building type 15°C  20°C  25°C
1 Storage areas <50 <35 <25
2 Offices, shops 50-65 35-50 25-35
3 Dwellings with low occupancy 65-80 50-60 35-45
4 Dwellings with high occupancy 80-95 60-70 45-55
5 Special buildings (e.g. laundries, breweries) ~ >95 >70 >55

Figure 5.1: ISO 13788 Condensation table
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5.2.1 ISO Condensation Table

The ISO Condensation Table shows the amount of condensate predicted at each interface in
the construction, and is the most accurate means of viewing the results of an analysis to SO
13788.

To view the ISO Condensation Table select View=1SO Condensation Table from the menu
bar.

The upper part of the table (Figure 5.1) shows the interfaces within the construction. When
you select an interface by clicking on it, the lower half of the table shows the amount of
condensation predicted at that interface. It shows the amount of condensate deposited or
evaporated each month, gc, and the accumulated condensate at the end of each month, Ma,
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Figure 5.2: Dewpoint graph for a roof with condensation predicted at the interface between
layers 5 and 6
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both measured in g/m? (negative numbers indicate evaporation). The results start with the first
month in which condensation is predicted, or January if no condensation is predicted in any
month. Guidance on interpreting results is given in BS 5250:2002 and BS EN 1SO 13788.

5.2.2 The Dewpoint graph

The Dewpoint graph plots the predicted temperature through the construction with dewpoint
temperature for the worst month®>. Condensation is predicted at any interface where the two
lines touch (see Figure 5.2). The orientation of the Dewpoint graph is determined by the
building element: walls are shown with layers running vertically and roofs with layers running
horizontally.

To open the Dewpoint graph select View=>Dewpoint graph from the menu bar or click the
Dewpoint graph button on the tool bar. To view the results for the month with the greatest
evaporation click on the Summer radio button in the Results to show section.

5The dewpoint temperature is the temperature at which saturation vapour pressure would occur. Any lower
temperature would result in condensation.
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5.2.3 The Results table

The Results Table shows the headline results for each interface in the construction. To view the
Results table select View>Results Table from the menu bar. When the table is open click the
Always on top box to keep it visible on screen while you continue to work on the calculation.
When you have finished, click Close to close the Results Table.

For calculations to ISO 13788 the significant columns are:
= ISO -Winter worst build up: the month in which the highest amount of condensate is
predicted to be deposited;
= ISO -Winter peak build up: the month which sees the highest cumulative amount of

condensation.

For each column the amount of condensate is shown in grams per square metre. The result
n/a means no condensation is predicted at that interface. You can see more detailed results
in the ISO Condensation table.

For calculations to BS 5250:1989 Appendix D the significant columns are:

* Winter buildup: the amount of condensate predicted over 60 winter days;
= Annual buildup: the amount of condensate carried forward after allowing for summer

evaporation,

For each column the amount of condensate is shown in grams per square metre (@/m?). Zero
shown in both columns means no condensation is predicted, while a negative number in the
annual buildup column indicates summer evaporation will be greater than winter deposition.

5.3 Using the previous calculation method

To use the BS 5250: 1998 calculation method untick the Use 2003 condensation method box
in the Environmental conditions dialogue. The dialogue box will now show the environmental
data for the BS 5250:1989 method.

External conditions The program sets standard values for external environmental conditions,
following BS 6229 and BS 5250, which are:

= summer temperature: 18°C.

= winter temperature: 5°C.

= summer relative humidity: 65%.

= winter relative humidity: 95%.
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If you need to calculate condensation risk for other external environments you can change
the standard values by typing new values into the text boxes. To return to the default values
for external environmental conditions click the Default button.

Condensation build up period Build-up of condensate is assessed over a standard 60 day
winter period: that value can be changed using the Condensation build up period box.

Internal conditions The internal temperature and relative humidity values will be determined
largely by the building use. You can enter design data or measured values in the four boxes,
or select one of the pre-defined building use groups listed in the Building Use drop-down
box: that will automatically set the temperatures and relative humidities to those defined in
BS 5250 and BS 6229, Table 7.

Once you have set the environmental conditions you can view the calculation results using
the Results table and the Dewpoint graph (see Fection 5.2).

Calculation options The BS 5250:1989 method does not allow for the removal of moisture by
air movement, however, the standard suggests some indication of the effect of vented cavities
can be obtained by assuming the air in the cavity is at outside conditions. This can done by
setting to zero the vapour resistances of the materials to the outside of a cavity.

For an explanation of the limitations of this technique please refer to BS 5250: 1989 page 76.

To use this option in JPA Designer:

1. In the Edit material dialogue set the cavity type to vented cavity.
2. From the menu bar select Options. The Calculation options dialogue opens.
3. Tick the box Set vapour resistance of layers above vented cavity to zero.

4. Click OK. The program sets the vapour resistances of all the layers to the outside of the
cavity to zero.

5.4 Outputting calculation results

The results of condensation risk analysis can be printed or produced as PDF files in the same
way as the results of U-value calculations (see pection 4.T0). The main differences are:

1. Before starting to print or create a PDF, tick the Condensation risk box on U-value mod-
ule status bar.

2. In the Sections To Print dialogue review whether you want to print the summer-time
condensation results and the ISO moisture table and tick the appropriate boxes.



6 SAP 2005 module

6.1 SAP 2005

The JPA Designer SAP 2005 module enables you to carry out calculations to demonstrate
a dwelling complies with the requirements of Part L 2006 (England and Wales), section 6
of Technical Standards 2007 (Scotland) and Part L 2006 Northern Ireland. The module also
lets you issue energy performance certificates (EPCs) for new dwellings', whilst the results of
calculations may be used as part of assessments under the Code for Sustainable Homes.

The SAP 2005 module uses the SAP version 9.81 methodology to calculate the Target Carbon
Dioxide Emission Rate (TER) and the Dwelling Carbon Dioxide Emission Rate (DER). The
module also checks for compliance against a number of other criteria set out in Approved
Document LTA and in the Domestic Heating Compliance Guide.

Whilst this section of the manual gives instructions on how to enter data into the program it
does not offer authoritative guidance upon SAP 9.81 nor the Building Regulations. We suggest
you use this manual in conjunction with the government's guide to SAP (available from the
BRE web site - www.bre.co.uk/sap2005), Approved Document L1A and the Domestic Heating
Compliance Guide (both available from the Planning Portal: www.planningportal.gov.uk).

6.2 Determining compliance

There are five criteria against which a new dwelling is tested to determine whether or not it
complies with the requirements of Part L2:

1. Meeting the TER: The Dwelling CO, Emission Rate, measured as the amount of CO;
per square metre of floor area emitted as a consequence of providing space heating, hot
water and lighting for a dwelling must be less than a target rate. That Target CO, Emis-
sion Rate, is based on the emissions from a notional dwelling of the same dimensions
as the proposed dwelling, but reduced by an improvement factor of 20%.

The SAP 2005 module calculates the TER using the data you enter about the proposed
dwelling and the default conditions specified in Appendix R of the SAP specification.

TIn order to issue an EPC you will need to be a member of a government approved accreditation scheme. You
can find more information on suitable accreditation schemes on our web site.
2The software also carries out similar tests for regulations in Scotland and Northern Ireland.
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2. Limits on design flexibility: To ensure long-term performance, and to prevent excessive
trade-offs between fabric and plant, Approved Document L1 sets out:

= maximum permissible fabric U-values (both worst case values and average values);
= maximum permissible air leakage rates;
 design limits for fixed building services;

= minimum proportions of low energy lighting.

The SAP 2005 module checks for compliance against all those standards.

3. Limiting the effects of solar gain in summer: The regulations require designers to make
provision to avoid excessive internal temperatures as a result of solar gain. Appendix P
of the SAP 9.81 document contains a method for testing levels of solar gain. The SAP
2005 module implements that method to test for compliance.

4. Quality of construction: The performance of the dwelling as built must be consistent
with that predicted by the DER: one measure is the air permeability rate, established by
pressure testing. For a dwelling which is pressure tested the measured air permeability
must be lower than 10 m3/m2hr and the DER calculated using the test result must be
lower than the TER.

The SAP 2005 module allows pressure testing data to be entered and will check for
compliance.

5. Operating and maintenance instructions: Regulation 16 requires an energy rating to be
prepared using SAP 2005 and fixed to a conspicuous place in a new dwelling. The
outputs from the SAP 2005 module can be used to meet that requirement.

6.3 Overview of the SAP 2005 module

Carrying out a SAP 2005 calculation using JPA Designer is straight forward. The main SAP win-
dow shows the on-going results of the calculation and the compliance status of the dwelling,
while the SAP Worksheet Values dialogue allows you to enter the data required for the calcu-
lation. Once you have finished entering data you can print off the results or make adjustments
to the data.

6.4 Preparing to carry out a SAP 2005 calculation
Before starting a SAP calculation you should ensure you have all the input data, including:

= dwelling floor area;

e U-values and areas of external elements (you can carry out the U-value calculations
using one of the JPA Designer U-value modules);

» whether or not approved construction details have been used, or have data on linear
thermal bridging;

e U-values, areas and orientation of windows, doors and roof lights;
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6.5

the proposed water heating system;

the proposed primary and secondary heating systems;
the ventilation strategy;

the design or achieved air permeability;

details of any photovoltaic cells or other low carbon technology.

Carrying out a SAP 2005 calculation

Once you have gathered all the necessary data about the dwelling you can carry out the SAP
2005 calculation. The main steps are:

6.6

. Create a new SAP 2005 calculation (see Fection 3.9).
. Open the calculation in the SAP module (see Fection 3-7).

. Enter the Project Information (see fection 6.7).

Open the SAP Worksheet Values dialogue and enter the dwelling data (see Fection 6.9).

. Check the compliance status on the main SAP window (see pecfion 6.6) and make any

necessary changes.

Produce print-outs or PDF files of the calculation results (see pection 6.20).

Save your project (see Fection 3.4)). We also recommend you have a daily back schedule
for your data.

The SAP window

The SAP window lets you access the SAP menus and tool bar and displays the results of
calculations (see Figure 6.1). The main features of the window are:

1.
2.

The menu bar

The SAP 2005 toolbar - the buttons give direct access to key program features and to the
tabs on the SAP Worksheet Values dialogue.

. The TER and DER results, with the percentage reduction of the DER against the TER and

Code for Sustainable Homes (CSH) level that reduction represents.

The CSH level is only a guide for the carbon emissions component of the Code: it is not
a full evaluation against the Code.

Fabric U-values - limits and averages

. Overheating risk assessment.

Carbon dioxide emission and SAP results
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Figure 6.1: The JPA Designer SAP window
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7

The

—_

10.
11.

12.

6.7

The
tion

. Compliance zone. This shows green for a pass and red for a fail. If the dwelling is failing
to comply hovering your mouse over this zone will bring up a tool-tip giving the primary
cause of failure (see Figure 6.7). Double clicking on the zone will open the Compliance
Checklist.

tool bar buttons are (Fig 6.3):

. Return to project manager window

. Print results

. Return to project manager window

Enter project information: opens the SAP Project Information dialogue.

. Dwelling dimensions: opens the Dwelling dimensions tab of the SAP Worksheet Values
dialogue.

. Ventilation information: opens the Ventilation information tab of the SAP Worksheet
Values dialogue.

. Walls, floors and roofs: opens the Walls, floors and roofs tab of the SAP Worksheet
Values dialogue.

. Water heating: opens the Water heating tab of the SAP Worksheet Values dialogue.
. Openings: opens the Openings tab of the SAP Worksheet Values dialogue.
Primary heating: opens the Primary heating tab of the SAP Worksheet Values dialogue.

Secondary heating: opens the Secondary heating tab of the SAP Worksheet Values di-
alogue.

EPC preview button: shows a draft EPC for the dwelling.
Project information in SAP

SAP 2005 module stores general information about the dwelling, in the Project Informa-
dialogue (Figure 6.4)). This includes address information, dwelling details and calculation

options.

6.7.

You

1 Address details

can either copy client and project address details which you entered in the Project Infor-

mation dialogue in the Project Manager window, or you can enter new data in the SAP 2005
module. You can also save and re-use client data (fecfion 3.3).

To copy project details from Project Manager:

1

. In the SAP module select Edit>Project Information from the menu bar. The Project
Information dialogue opens.
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Figure 6.4: The Project Information dialogue for the SAP 2005 module
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2. Click the Inherit button. Any information you entered in Project Manager is copied to
the Project Information dialogue here.

3. Click OK.
To enter new project details:

1. In the SAP module select Edit=>Project Information from the menu bar. The Project
Information dialogue opens.

2. Enter project information by typing it into the appropriate fields. Use the <Tab> key to
move between fields. Click OK when you have entered all the data you need.

You can also add plot numbers and drawing references to link the calculation to a particular
dwelling on site.

The UPRN box and the get UPRN and clear UPRN buttons are only used when preparing to

issue an EPC for a completed dwelling. For instructions on using them please see our guide to
issuing EPCs.
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6.7.2 Dwelling details

The Project Information dialogue also contains general information about the dwelling, in-
cluding the type of building, the country and the location.

 Building type: this is used in the Energy Performance Certificate. Select the closest
matching value from the drop-down.

= Country: the different parts of the UK have implemented SAP 2005 in slightly different
ways. You must use the Country drop-down to select the correct location to ensure the
dwelling is tested against the appropriate regulations.

e Location: this is used in the Energy Performance Certificate. Select the closest matching
value from the drop-down.

6.7.3 Calculation options

The bottom of the Project Information dialogue contains several calculation options:

» Treat low e glass coating as “soft': soft coatings allow more solar flux through glass
and will increase solar gain.Tick the box to apply this option to all low-E glass in the
calculation.

= Enter gross opaque element areas: the SAP 2005 calculation is based on the areas of
walls and roofs net of windows. If you select this option you only have to enter the gross
areas of walls and roofs, and the program will use the window and roof light areas to
calculate the net areas.

If you change the setting of this box the software then close the Project Information the
program asks if you want to use that setting as the default value for future calculations.

» Boiler comes under the exception procedure allowed in Part L: from 1 April 2005 new
or replacement gas boilers should be condensing boilers, unless the exemption proce-
dure in the Domestic Heating Compliance guide applies. Only tick this box if the boiler
is exempt.

= SAP 9.81 (post April 1st, 2008): after April 2008 SAP calculations must be carried out
using the SAP 9.81 methodology, so this box must be ticked.

Dwellings which received building control approval before April 2008 should still be
assessed using SAP 9.80. However, to produce an EPC for such a building you will have
to convert it from 9.80 to 9.81 by ticking the box.

6.8 Entering project data

The data for the SAP calculation is entered using the SAP Worksheet Values dialogue. To
open the SAP Worksheet Values dialogue at the start of a calculation click on the Dwelling
dimensions button on the toolbar or select Edit=Dwelling dimensions.

The dialogue is organised by a series of tabs, each covering one part of the SAP input data.
The tabs are listed at the top of the dialogue in the same order as they appear in the Edit menu
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Figure 6.5: The Tabs on the SAP Worksheet Values dialogue

SAP Worksheet ¥alues

Dimensions IWQ"S, roofs & floors] Qpenings] W ater heating] Primary heating] Secondary heating | Wentilation | Overheating | PV & &l Tech. ]

Figure 6.6: The buttons on the SAP Worksheet Values dialogue

0K | Cancel | Apply | Help | | Mest = |

(see Figure 6.5). If your screen is not wide enough to display all the tabs you can use the arrow
keys to scroll left or right along the list.

To move between sections simply click on the tabs. We recommend you start with the
Dwelling Dimensions tab and work from left to right, finishing with the PV & Alt Tech tab.

At the bottom of the dialogue are a series of buttons (Figtre 6.9):-

» OK: Revises the calculation taking account of any changes you have made to the data,
and closes the SAP Worksheet Values dialogue.

= Cancel: Closes the SAP Worksheet Values dialogue but ignores any changes you have
made to the calculation.

« Apply: Revises the calculation, taking account of any changes you have made to the
data, but leaves the SAP Worksheet Values dialogue open.

With a monitor set to 1024 by 800 pixels or higher, it is possible to see the main SAP
window and the SAP Worksheet Values dialogue at the same time. By using the Apply
button you can see the effect of design changes upon the calculation immediately.

* Help: Gives you access to the government's SAP guidance and an on-line version of
this manual.

 Last: Takes you to the previous tab on the dialogue.

» Next: Takes you to the next tab on the dialogue.

CAUTION: When you enter data for the first time in any calculation you must enter all
the data required for the calculation before the software can save it. If you leave the SAP
Worksheet Values dialogue before entering enough data then the data you have entered will
not be saved.

6.9 Dwelling dimensions

The area and average room height for each storey are used throughout the SAP calculation, for
example to determine hot water and lighting usage and the rate of heat loss through ventilation.
The data is entered using the Dwelling dimensions tab of the SAP Worksheet values dialogue.

The Dwelling dimensions tab requires the following data:
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Figure 6.7: The Dimensions tab

Area Avw. Room Yolurne

[rré] height [m] [r]
Basement floor ’W u IW = 0.00
Ground floar [1] ’W " W = 9510
Ground floar [2] ’W b W = 0.00
Exposed flaor ’W % IW = 0.oa
First Flaar ’W " W = 11011
Second floor ’W b W = 0.00
Third and ather floors ’W " IW = 0.00
Total floor area 20.02
Diwelling volume 206.21

Tatal floor area [ré] which is living area’ i.e. iz acceszible or enter a fraction
fram the living room without opening doors or using stairs 1682 bebween 0 and 1 0.21

Fraction of low energy lighting [Appendix L] [enter 0 if there iz no low energy ighting] {0300

Building faces :- |South ﬂ
Application date | 31/03/2007 =l

« The floor area, in m? and the average room height for each storey. JPA Designer will
calculate and display the volume of each storey, the total floor area of the dwelling and
the total volume of the dwelling. It is helpful to enter the values against the appropriate
line of the table, but not essential.

There are two lines for Ground floors, to allow for dwellings which have a double height
lounge. The Exposed floor line may be used for floors of apartments which are over
garages, parking bays or walkways.

Floor areas are measured to the internal surfaces of the walls bounding the dwelling, and
should include all internal walls and built-in cupboards accessible from the occupied
area of the dwelling and all porches and conservatories which are heated and form part
of the habitable space. (Exclude porches and conservatories which are not heated and
are clearly divided from the living space.)

The average room height for the lowest floor is measured from finished floor surface to
ceiling surface. For every other storey, the height is measured from the ceiling of the floor
below: for example, the height of the second storey in a two storey house is measured
from the underside of the ceiling of the first storey, to the underside of the ceiling of the
second storey. This convention ensures that the volume of the floor structure is included
within the calculation.

For room in the roof constructions you will need to determine an average storey height.

= Total floor area which is living area: Enter the area of the main living room of the
dwelling. JPA Designer will calculate the fraction that forms of the total floor area. The
living room is defined as the room marked on the plan as the lounge or living room, or
the largest public room. The area of other rooms which are not separated from the living
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Figure 6.8: The Walls, Roofs and Floors tab

[ Enter Htb value manually  Hep [0,0000 Calculate it....

Detailing
" Mew dweling, details are Accredited Constuction Details
(v Details are NOT Accredited Construction Details

Ma. Element type Met Area Ll-value Awll Factared LA

(] [w/imek] IR [14//K]

Pitched roo lated betweer
1 ‘wialls, Partial fill cavity wall 79.52 0.25 13.838 13.838
2 Ground floors, Solid ground floar 40.04 021 a4 a4

\Edit... | Duplicate | @Delete... |

room by doors should also be included. However, the living area cannot extend over
more than one storey.

= Fraction of low energy lighting: enter the fraction of fixed outlets which will accept only
low energy lamps (a figure of 25% is entered as 0.25. Approved Document L1A requires
1 outlet in 4 or 1 outlet per 25m? of floor area to be low energy. The SAP calculation
will use the fraction you enter, but the DER calculation is capped at a maximum 30%
of fixed outlets being low energy.

= Building faces: Select the orientation of the front face of the dwelling from the list. The
value is used in conjunction with the window orientation data to determine solar gain.

= Application date; Enter the date on which the dwelling will be submitted to the Building
Control Body. Clicking the down arrow will open a calendar.

6.10 Walls, roofs and floors

The data on walls, roofs and floors -- the opaque building fabric -- is used to calculate the rate
of transmission heat loss for the dwelling. The data is entered using Walls, roofs & floors tab
of the SAP Worksheet values dialogue (Figure 6.9).

You must enter data for each element which separates the building interior from outside, or
from an unheated space. Elements which separate two heated spaces (party walls and separat-
ing floors) are ignored at this point. You must also take account of heat losses through thermal
bridging at the junctions between elements (see Fubsection 6.10.2). Data for elements is en-
tered using the Element dialogue (see Figure 6.9), whilst data for linear thermal bridging is
entered on the Walls, roofs & floors tab.

To define a new element:-
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1. Click the New button; the New Element dialogue opens.
2. Enter the data for the element then click OK. JPA Designer shows the summary data new
element in the element list.

To edit an element:-

1. Click the element to edit then click the Edit button. The Edit Element dialogue opens.

2. Make the changes to the element, then click OK.
To duplicate an element:-

1. Select the element to duplicate by clicking on it once.
2. Click the Duplicate button. A copy of the element is created.

3. Select the new element and click Edit to make changes.
To delete an element:-

1. Select the element to delete by clicking on it once.
2. Click the Delete button. A confirm dialogue appears.

3. Click Yes to delete the element, or No to cancel the deletion.

6.10.1 Building elements

The Element Dialogue is used to enter data on each of the dwelling's opaque elements (see
oure 6.9): it takes the following data:

e Element: Use the drop-down to set the type of element from the list. The element type is
used to for checking permissible U-values and for setting openings. The available types
are:

— Pitched roofs insulated between joists;

- Walls;

— Ground floors;

— Floors (floors other than ground floors, such an exposed floor over a parking area);
— Sloping walls, skillings, cambceils (used for room-in-the-roof constructions);

— Flat roofs;

— Pitched roofs with integrated insulation (e.g. SIPS);

— Pitched roofs insulated between rafters (warm' roofs);

— Vehicle doors;

— Basement floors;
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Figure 6.9: The Element dialogue

MewElement x|

Element I j
e

Enter areas INcluding doors, windows rooflights
Avrea (including glazing) (]

U-walue [ ek I Effective thermal resistance ID ? HE|D|

Link to this U -value calculation el Wi s
I j Eerimeter [m] I
LCost [£/n¥) I

Description

 OK I X Eancell

— Basement walls;

= Curtain wall: Tick this box if the wall element consists of curtain walling.

Curtain walling has to be treated differently from normal walls in order to obtain the
correct values for heat loss and solar gains. The area of wall should be entered as normal,
but the U-value set to that of the whole curtain wall system. The window area should
also be that of the whole facade, with the same U-value.

« Area: enter the area of the element, in m2, which should be measured to the boundaries
of internal finished surfaces. If you have chosen to use gross areas for opaque elements
there is no need to subtract the areas of openings from wall or roof areas.

If you have chosen to use gross areas the text above the Area box will read Enter areas
INcluding doors, windows rooflights. If it reads EXcluding doors, windows rooflights
you must enter net areas.

e U-value: Enter the U-value in the text box. If you have already carried out the U-value
calculation in the same JPA Designer project you can select it using the Link to this
U-value calculation drop-down. that creates a permanent link between the element
in the SAP calculation and the U-value calculation; the software will update the SAP
calculation if the U-value changes.

U-values for walls and roofs should be calculated using the method described in ISO
6946, U-values for ground floors should be calculated using the method described in
ISO 13370.

« Effective thermal resistance of unheated space (Ru): The Ru coefficient is used to adjust
the U-value of an element to allow for the beneficial effect of an enclosed but unheated
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space to its exterior. The commonest unheated spaces are integral garages in houses
and access corridors to apartment blocks: some parts of room-in-the-roof constructions
are also treated as unheated spaces. Values for Ru are given in section 3.3 of the SAP
documentation; clicking the Help displays the relevant guidance.

= Description: An optional text description of the element can be entered in the Descrip-
tion text box. A description makes it easier to distinguish between several elements of
the same type when editing a calculation.

e Perimeter and Cost: these boxes should be ignored.

6.10.2 Linear thermal bridging

SAP 2005 takes account of the increased rate of heat loss at the junctions between elements,
by calculated the total rate of heat loss from linear thermal bridges, HTB. There are two ways
of entering the necessary data, both of which are found on the Walls, Roofs & Floors tab.
Further information on the treatment of linear thermal bridging can be found in Appendix K
of the SAP documentation.

6.10.2.1 The simplified method

JPA Designer can calculate an approximate value for HTB by multiplying the total area of
the exposed elements (floors, walls and roofs) by a factor, y. Where the dwelling is designed
using accredited construction details y = 0.08, otherwise y = 0.15 (in the TER calculation y =
0.11).This simplified method will give higher rate of heat loss compared to the full calculation
method.

To use the simplified method in JPA Designer:

» From the Detailing radio buttons select either New dwelling details are accredited con-
struction details or Details are not accredited construction details.

6.10.2.2 The full calculation method

The rate of heat loss through one metre of linear thermal bridge is described by its psi value
(). The heat flow rate for a bridge is determined by multiplying the bridge psi value by its
length. The heat flow rate for the dwelling, HTB, is the sum of those heat losses for every
bridge in the dwelling perimeter. This full calculation method gives a more accurate result
than the simplified method.

To use the full calculation method in JPA Designer:

1. Tick the box Enter HTB value manually.
2. Click the Calculate it button. The Calculate HTB dialogue opens (see Figure 6.10.

3. For each type of bridge enter the Achieved linear thermal transmittance (the Psi value)
and the Detail length.

The initial values in the Achieved linear thermal transmittance column are those of the
accredited construction details.

4. Click OK. The dialogue closes and the HTB value is shown in the Htb box of the Walls,
Roofs & Floors tab.
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Figure 6.10: The Calculate Htb dialogue

x|
Junction type Accredted linear Achieved linear Detail lencth (m) Linear thermal
thermal thermal transmittance x
transmittance transmittance Dretail lencth
(WA (e (im0

Steel lintel with perforated steel baze 0.s0 0.00 0.00
Cther lintels (including other steel lintels) 0.0 0.30 0.00 0.00
Sill 0.04 0.04 0.00 0.00
Jamb 0.03 0.0s 0.00 0.00
Ground floor 016 IR 0.a0 0.00
Intermediste floar within & dwelling ooy o.a7 0.00 0.00
Intermediate floor hetween dwelings * 014 014 0.00 0.00
Balcony within & dweling 2 0.00 0.00 0.00 0.00
Balcony between dwellings * 2 0.04 0.04 0.00 0.00
Eaves (insulation at ceiling level) 0.06 0.06 0.00 0.00
Eaves (insulation at rafter level) 0.04 0.04 0.00 0.00
Gahle (insulation st ceiling level) 024 0.24 0.00 0.00
Gahle (insulation st rafter level) 0.04 0.04 0.00 0.00
Carner (normal) 0.09 0.09 0.00 0.00
Corner (inverted) -0.09 -0.09 0.00 0.00
Party wall between dwellings * 0.06 0.06 0.00 0.00

Tiotal : 0.00

1 For these junctions, half the walue of linear thermal tranzmittance iz applied to each dwelling.

2 Thiz is an externally supported balcony (the balcony slab is not & continustion of the floor slak)
wehere the wall insulation iz continuous and not bridged by the balcony slab.

6.11 Openings

Cancel

Openings, windows and doors, affect three aspects of the SAP calculation:

* Heat loss: assessed through the U-value.

= Solar gain: assessed through the g window value.

» Daylighting: assessed through the type of glazing.

69

Data on openings is entered using the Openings tab of the SAP Worksheet Values dialogue.
The Openings tab lists the dwelling's windows, doors and rooflights, grouped by building
element. The buttons below the list allow you to create, edit and delete openings. You can
enter each opening individually, or you can group the openings on each face of the building
into one area (as long as they have the same specification). For each opening the data is

entered using the Doors, Windows & Rooflights dialogue.

To define a new opening:

1. In the Openings tab click the New button.

dialogue opens.

2. Enter the data for the opening and click OK.

The New Doors, Windows & Rooflights
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Figure 6.11: The Openings tab

Mo, |Element type Area U-value [ Qrientation |Frame Air gap

(] () mm

Flefac o fciaia dafean it Sl

Sl P ¥ canty sl

1.0 Window - Double-glazed. airfiled, low-E, En=0.1, 072 210 Left FC-u 12mm
zoft coat [East), WE

soft coat [Marth], W

soft coat [South), W5

soft coat [Marth], W2

soft coat [South), w1

zoft coat [South), Wi

soft coat [Morth], /3

[ Mews... | \Edit... | Duplicate @ Delete. .. |

ir-filed ack

1 .2 Window - Double-glazed. air-filed. low-E, En=0.1, 1.44 210 Back FC-u 12mm
1.3 “Window - Double-glazed. airfilled, low-E. En=0.1, 110 210 Front PC-u 12mm
14 Window - Double-glazed. airfiled, low-E. En=0.1, 110 210 Back FC-u 12mm
1.5 window - Double-glazed. air-filed, low-E, En=0.1, 1.44 210 Frant PYC-u 12namm
1.6 Window - Double-glazed. airfiled, low-E. En=0.1, 1.44 210 Front FC-u 12mm

1.7 “window - Double-glazed, air-filled, low-E. En=0.1, 1.44 210 Back PYC-u 12mm

To duplicate an opening:
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Duplicating an opening creates a new copy of the original opening which can then be edited:
as most openings will have the same parameters using the duplicate facility can save time on

data entry.

1. In the Openings tab select the opening you want to duplicate.

2. Click the Duplicate button. A copy of the opening is created.

3. Double click on the duplicated opening to edit it.

To edit an existing opening:

1. Double click on the opening in the list in the Openings tab. The Edit Doors, Windows

and Rooflights dialogue opens.

Alternatively, you can select the opening then click the Edit button.

2. Make your changes then click OK.
To delete an opening:

1. Select the opening in the list in the Openings tab.
2. Click the Delete button. A confirmation dialogue appears.

3. Click Yes to delete the opening, or No to retain it.
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Figure 6.12: Changing the U-values of several openings at the same time

Change Multipe U- x|
Enter a new L-value For al the selected
items:

To change multiple U-values:

This function enables you to revise the U-values of several openings at once.

1.
2.

Select the first of the openings by clicking on it once.

Hold down the <shift> key and click the last of the openings.

. Click the Change U-value of selected openings button. The Change Multiple U-values

dialogue opens (see Figure 6.12).

Enter the new U-value then click OK. The U-values are changed.

6.11.1 The Windows, Doors and Rooflights dialogue

The Windows, Doors and Rooflights dialogue is used to enter the data about the openings
within the dwelling (see Figure 6.T3]: the dialogue is headed either New Doors, Windows &
Rooflights or Edit Doors, Windows & Rooflights). The dialogue requires the following data:

Opening Type: Use the drop-down to select whether it is a window, rooflight or door.

Opening within: Use the drop-down to select which element (floor, wall, roof) which
contains the opening. The software uses this information to calculate the net areas of
the elements.

Glazing: Use the drop-down to select the type of glazing, considering the number of
leaves of glass, the gas between them and any low emissivity (low-E) coating.

Even if you go on to enter a manufacturer's U-value and/or g window value you must
still make a selection here to set the correct parameters for daylight.

Double-glazing air gap: Use the radio buttons to select one of the default values or enter
your own value.

Frame type: Use the radio buttons to select the best match.

Source of U-value: If you select Default the software will use the built-in values for the
U-value and solar transmittance. If you select Manufacturer the software will expect
you to enter a U-value, but will use a default solar transmittance based on the glazing
and frame type. If you select BFRC data the software will expect you to enter a U-value
and solar factor (g window value). The g window value must be certified by the British
Fenestration Rating Council.
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Figure 6.13: The openings dialogue

New Doors, Windows 2: Rooflights x|
Opening tupe
Opening within | j
Glazing | ﬂ
Double-glazing air gap Frame type
" Bmm " Wood " Metal, 4mm thermal break " Metal, 20mm thermal break
= 12mm i~ PYCou ™ Metal, Bmmn thermal break i~ Metal, 32mm thermal break
Other i
"~ 16Bmm (" Metal, no thermalbreak " Metal, 12mm thermal break
U-walue [k Source of L-value ; o ) ) ) .
g windaw value:- Light tranzmittance i determined by glazing type

Area (] € Default € Manufacturer " BFRC data [zingle, double or triple] so make sure you select

the comect glazing twpe.

Description
Opening Orientation AP | ﬂ widkh fram) | Height (] ’—
" Front
. Overhang [uzed for .
Left front " Right front overheating assessment] “width{rrm] Depth ()

Blinds, curtaing & extemal shutters
. Fraction of daylight
[t Mare j hours clozed D
Overshading
 Right back " Heawy (>80 % sky blocked)
" More than average [60-80 % sky blocked)
" Back {* Average or unknown [20-60 % zky blocked)
" Ve litte [<20 % zky blocked)

0K | X Cancel

Left back

" Top [raof]
" Unspecified

e U-value: If source of U-value is set to Default this box will be greyed out. Otherwise
enter the manufacturer supplied U-value.

« g window value: Only enter a g window value in here if it is BFRC certified.

e Area: You can enter the area directly into the Area box, or you can select a size from
the Window size drop-down, or you can enter the Width and Height of the opening.

Note: the Area is entered in metres square, but the values for Width and Height are
entered in millimetres (mm).

= Opening orientation: The direction in which the opening faces determines how much
light it will receive and will therefore affect how much solar flux will pass through
the opening. The orientation of an opening is set relative to the front elevation of the
dwelling: usually that which contains the front door. Set the orientation using the radio
buttons. Rooflights always face Top. If you are unsure which way the building will be
facing then select Unspecified.

Make sure the Front elevation here is the same one you selected in the Building faces
drop-down in the Dimensions tab.

= Overhang: Features such as balconies or brise soleil which overhang a window will
reduce the amount of sunlight falling on it in summer, and so reduce the risk of over-
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heating. If there is such an overhang enter its Width and Depth, both in mm. The depth
is measured from the outer edge of the overhang to the external face of the glazing.

Blinds, curtains and external shutters: These will also reduce the amount of solar gain
and the risk of overheating in summer. Use the drop-down to select the type of shading
and then set the Fraction of daylight hours closed.

Appendix P of the SAP documentation gives some guidance of reasonable assumptions
for these occupant-determined values.

Overshading: The extent to which the sky is obscured by trees and neighbouring build-
ings will determine the amount of sunlight and solar flux passing through the glazing.
Set the degree of overshading using the radio buttons. Select Average or unknown if you
cannot establish the amount of overshading.

6.12 Water heating

SAP considers the amount of energy used to heat domestic hot water such as that used for
bathing, laundry and dishwashing. The demand for hot water is based upon the floor area of
the dwelling. Data on domestic hot water is entered using the Water heating tab of the SAP
Worksheet values dialogue.

The first step is to select the type of water heating system using the Source of domestic hot
water drop-box. Once you have made a selection the program will display the appropriate
data entry fields. The hot water sources are:

Hot water storage tank.

Instantaneous water heating at point of use.

Combination boiler.

Community heating scheme.

Multi-point gas water heater or heat exchange built into a gas warm air system.
Boiler with thermal store.

Combined primary storage unit (CPSU).

MicroCHP.

Community heating scheme providing domestic hot water only.

6.12.1 Hot water storage tank

This represents hot water which is heated by the central heating boiler or immersion coil, then
stored in a tank ready for use. Enter the following data:

Hot water tank volume: use the radio buttons to select one of the default values or enter
the actual volume in the Other volume box.
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Figure 6.14: Data fields for a hot water storage tank

Source of domestic hot water

Hot water storage tank ﬂ
Hot water tank volume Storage tank ingulation Hot water tank heater
" 1100tres  Other volume (1) (v Foam  Thickness (mm] || Single electric immersion heater
™ 160 litres ~ B0.00 " Diual electrc immersion heater
1600 Jacket .
210 lires {+ Boiler feed [~

M anufacturer's declared loss factor

Declared loss factor if
ki [kahddap]

» Storage tank insulation: use the radio buttons to select the type of insulation, then enter
its Thickness in mm.

* Hot water tank heater: use the radio buttons to select the heat source. If you select an
immersion heater an additional tick box is displayed for selecting off-peak electricity.

« Manufacturer's declared loss factor: Use the box to enter a declared heat loss factor
supplied by the tank manufacturer instead of relying on the default values in SAP 2005.

« Use the four lower tick boxes to indicate whether:
« the hot water tank (cylinder) is in the heated space;

 the primary pipework between the boiler and tank is insulated (tick box only displayed
if boiler feed is selected);

» there is a thermostat in the hot water tank;

« there is a separate timer for the domestic hot water.

Those features indicated by asterisks are required by Building Regulations: the dwelling
will fail if they are not present.

If the dwelling has solar panels complete the Solar panel section of the Water heating tab (see
Eubsection 6.12.10).

6.12.2 Instantaneous water heating at point of use

For a system which heats the water at the point of use, as it is required, you need only select
the Fuel using the radio buttons.

6.12.3 Combination boiler

Combination boilers provide heating and hot water: they may be instantaneous, with no stor-
age at all, or they may contain small primary or secondary storage tanks. Use the Combination
boiler type radio buttons to select the type.

If you have selected Instantaneous there is no further data to enter. For a boiler with a primary
or secondary store enter the following data:
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Figure 6.15: Data for an instantaneous water heater

Source of domestic hot water

1 heating at point of use

Fuet
* Electic " Bulk LPG

" Mains gaz © Propane

Figure 6.16: Hot water options for combination boilers

Source of domestic hot water

Combination baoiler ﬂ
Hot water tank volume Storage tank insulation Combination bailer type
 1100tes  Other volume (1) (+ Foam  1hickness [mm]
160 litres S B0.00
210 - :
v 210 litres " Storage with secondary store

M anufacturer's declared loss factor

Declared loss factor if
krnown [kiwh/day]

« Hot water tank volume: use the radio buttons to select one of the default values or enter
the actual volume in the Other volume box.

= Storage tank insulation: use the radio buttons to select the type of insulation, then enter
its Thickness in mm.

» Manufacturer's declared loss factor: Use the box to enter a declared heat loss factor
supplied by the tank manufacturer instead of relying on the default values in SAP 2005.

If the dwelling has solar panels complete the Solar panel section of the Water heating tab (see
Eubsection 6.12.T0).

6.12.4 Community heating scheme hot water

The hot water for dwellings heated by community heating schemes can provided by immersion
heaters or by a heat exchanger fed from the scheme. Enter the following data:

« Hot water tank volume: use the radio buttons to select one of the default values or enter
the actual volume in the Other volume box.

= Storage tank insulation: use the radio buttons to select the type of insulation, then enter
its Thickness in mm.

= Hot water tank heater: use the radio buttons to select the heat source. If you select an
immersion heater an additional tick box is displayed for selecting off-peak electricity.

* Manufacturer's declared loss factor: Use the box to enter a declared heat loss factor
supplied by the tank manufacturer instead of relying on the default values in SAP 2005.
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Figure 6.17: Hot water options for community heating schemes

Source of domestic hot water

Community heating scheme ﬂ
Hot water tank volume Storage tank ingulation Hot water tank heater
" 1100tres  Other volume (1) & Foam  1hickness (mm] || % Single electric immersion heater
™ 160 litres ~ B0.00 " Diual electrc immersion heater
210 Jacket .
(* 210 lires " Boiler feed [~

M anufacturer's declared loss factor O peak electicity i ion b
Declared loss factor if v peak electncity immersion heaters
ki [kahddap]

Figure 6.18: Data entry for gas water heaters or heat exchangers

Source of domestic hot water

H ulti-point g ge built inta &
Hat water tank volurme Storage tank insulation
" 1100itres  Other volume 1] (+ Foam Thickness [mm)
" 160 litres ~ Jack 50,00
160.0 acket
210 litres

M anufacturer's declared loss factor

Declared loss factor if
krniown [kiwh/day)

* Use the four lower tick boxes to indicate whether:
« the hot water tank (cylinder) is in the heated space;

« the primary pipework between the boiler and tank is insulated (tick box only displayed
if boiler feed is selected);

e there is a thermostat in the hot water tank;

« there is a separate timer for the domestic hot water.

Those features indicated by asterisks are required by Building Regulations: the dwelling
will fail if they are not present.

If the dwelling has solar panels complete the Solar panel section of the Water heating tab (see
Fubsection 6.12.10).

6.12.5 Multi-point gas water heater or heat exchange built into a gas warm air
system

This represents systems with one gas-fired water heater providing hot water to a number of

outlets, or a water heater which uses a heat exchanger built into a warm air heating system.
Enter the following data:

= Hot water tank volume: use the radio buttons to select one of the default values or enter
the actual volume in the Other volume box.
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Figure 6.19: Data entry for a thermal store hot water system

Source of domestic hot water

B oiler with & thermal store

Hot water tank. valume Storage tank inzulation Hat water tank heater
" 1100itres  Other volume 0] (+ Foam Thickness [mm] ||
" 160 litres 50.00 i
160.0 g :
210 lires O L]
Thermal store type
M anufacturer's declared loss factor " Haot water only
Declared lozs Factor if ’— ' Integrated
knovan [kKwhiday]

|z the Thermal Stare close coupled?
CPSU/Thermal store in airing cupboard| | Yes  No

" Yes i+ Mo

[ Thermal stare or CPSU has seperate timer far heating stare

» Storage tank insulation: use the radio buttons to select the type of insulation, then enter
its Thickness in mm.

« Manufacturer's declared loss factor: Use the box to enter a declared heat loss factor
supplied by the tank manufacturer instead of relying on the default values in SAP 2005.

» Use the four lower tick boxes to indicate whether:
« the hot water tank (cylinder) is in the heated space;

= the primary pipework between the boiler and tank is insulated (tick box only displayed
if boiler feed is selected);

» there is a thermostat in the hot water tank;

= there is a separate timer for the domestic hot water.

Those features indicated by asterisks are required by Building Regulations: the dwelling
will fail if they are not present.

If the dwelling has solar panels complete the Solar panel section of the Water heating tab (see
Eubsection 6.12.10).

6.12.6 Boiler with thermal store

This system represents a thermal store which contains water heated by a separate boiler. Do-
mestic hot water is provided by means of heat exchanger within the store.

Enter the following data:

« Hot water tank volume: use the radio buttons to select one of the default values or enter
the actual volume in the Other volume box.

= Storage tank insulation: use the radio buttons to select the type of insulation, then enter
its Thickness in mm.

* Hot water tank heater: use the radio buttons to select the heat source. If you select an
immersion heater an additional tick box is displayed for selecting off-peak electricity.
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« Manufacturer's declared loss factor: Use the box to enter a declared heat loss factor
supplied by the tank manufacturer instead of relying on the default values in SAP 2005.

« Use the radio buttons and tick boxes to indicate whether:

The thermal store is integrated or hot water only.

The thermal store is in an airing cupboard.

The thermal store is close coupled. Close coupled means the store is either within
the same casing as the boiler, or separated from the boiler by no more than 1.5m
of insulated pipework.

There is a separate timer to the thermal store for the heating store.

Use the four lower tick boxes to indicate whether:

the hot water tank (cylinder) is in the heated space;

= the primary pipework between the boiler and tank is insulated (tick box only displayed
if boiler feed is selected);

there is a thermostat in the hot water tank;

there is a separate timer for the domestic hot water.

Those features indicated by asterisks are required by Building Regulations: the dwelling
will fail if they are not present.

If the dwelling has solar panels complete the Solar panel section of the Water heating tab (see
Eubsection 6.12.10).

6.12.7 Combined primary storage unit (CPSU)

A Combined Primary Storage Unit provides hot water by means of heat exchanger within the
primary store. Enter the following data:

= Hot water tank volume: use the radio buttons to select one of the default values or enter
the actual volume in the Other volume box.
= Storage tank insulation: enter its Thickness in mm. Regulations require foam insulation.

« Manufacturer's declared loss factor: Use the box to enter a declared heat loss factor
supplied by the tank manufacturer, instead of relying on the default values in SAP 2005.

» Specify whether the CPSU is in an airing cupboard, using the radio buttons,

» Specify the winter operating temperature of the CPSU; use the radio buttons to set one
of the default values, alternatively, enter your own.

» Specify the size of the CPSU cylinder; use the radio buttons to set one of the default
values, alternatively, enter your own.

= Specify whether the CPSU as a separate timer for the heating store.



CHAPTER 6. SAP 2005 MODULE 79

Figure 6.20: Data entry for CPSU hot water supply

Source of domestic hot water

Hat water tank valume Starage tank inzulatior Hat water tank heater

" 1100tes  Other volume (1) (v Foam  Thickness [mm] ||
" 1E60 litres ,— C 50,00 i
¢ 20les |07 = r

Manufacturer's declared loss factar

Declared loss factor if
known [Kw'hiday]

CPSAT hermal store in aiing cupboard
" Yes * Mo

i i CPSU Cylinder =i
CFSL inter operating temperature 270 ;'t:r;se;flz:DD ires £ 390 lires ™ Thermal stare or CPSL has seperate timer for heating store
(+ 85°C{ 90°C (" 95°C
Other ['C) |85 DOther [litres] [160.0 v Cylinder in heated space

[v Inzulated primary*
[v Cplinder thermostat* v Separate timer for domestic hot water
* Required by the Building Regulations

e Use the four lower tick boxes to indicate whether:

« the hot water tank (cylinder) is in the heated space;

e the primary pipework between the boiler and tank is insulated;
« there is a thermostat in the hot water tank;

« there is a separate timer for the domestic hot water.

Those features indicated by asterisks are required by Building Regulations: the dwelling
will fail if they are not present.

If the dwelling has solar panels complete the Solar panel section of the Water heating tab (see
Eubsection 6.12.70).

6.12.8 MicroCHP

This represents hot water provided by a domestic combined heat and power (microCHP) sys-
tem.

Enter the following data:

= Hot water tank volume: use the radio buttons to select one of the default values or enter
the actual volume in the Other volume box.

= Storage tank insulation: use the radio buttons to select the type of insulation, then enter
its Thickness in mm.

« Manufacturer's declared loss factor: Use the box to enter a declared heat loss factor
supplied by the tank manufacturer instead of relying on the default values in SAP 2005.

« Indicate whether there is a summer immersion heater using the tick box.

If the dwelling has solar panels complete the Solar panel section of the Water heating tab (see
Eubsection 6.12.10).
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Figure 6.21: Hot water settings for a microCHP system

Source of domestic hot water

Hot water tank volume Starage tank inzulatior

" 1100ites  Other volume (1) (+ Foam  Thickness [mm]
" 160 litres ’— ¢~ Jacket |50.00

210 litres 1800

Manufacturer's declared loss factor

Declared loss factor if ’—
known [Kw'hiday]

[~ Micro-CHP summer immersion heater

Figure 6.22: Settings for a community heating scheme which supplies only domestic hot water

Source of domestic hot water

Community heating scheme - domestic hot water only ﬂ
Hat water tank volunie Starage tank insulation Hat water tank heater
1100tz Other valume (1 (s Foam  Vhickness(mm] || ¢~ Single electic immersion heater
" 160 litres ‘» 50.00 " Dual electric immersion heater
1E0.0 Jacket .
" 210 litres (s Boiler feed [~

M anufacturer's declared loss factor

Declared loss factar if
krown [kwhiday]

Hot water only community heating

Fuel uzed by commuity scheme |alzeaieiil iR e

Efficiency of community bailer, {7,000 is CHP  CHP heat to power ratio [0.000

heat pump or CHP %] = P
Heat digtribution system
Maing piping system installed before 1991, not pre-insulated, medium.high termp distribution [120/140°C], full flaw systeﬂ

[ Haot water cylinder in within dwelling

6.12.9 Community heating scheme providing domestic hot water only

This system represents hot water provision by a community heating scheme which does not
provide the space heating.

Enter the following data:
= Hot water tank volume: use the radio buttons to select one of the default values or enter
the actual volume in the Other volume box.

» Storage tank insulation: use the radio buttons to select the type of insulation, then enter
its Thickness in mm.

= Hot water tank heater: use the radio buttons to select Boiler feed as the heat source.

« Manufacturer's declared loss factor: Use the box to enter a declared heat loss factor
supplied by the tank manufacturer instead of relying on the default values in SAP 2005.

= Select the Fuel used by the community scheme using the drop-down.
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Figure 6.23: Data entry for solar water heating

Solar panel details — =
Solar collector type Direction Overshading
Aperture area of collector [net] () |0.00 (™ Evacuated tube collector " Sauth ™ Heavy [»30 % sky blocked)
Zerorloss collector efficiency 0.00 (" Flat plate callectar  SE/SW @ Sigrifizant [»60-80 % sky blocked)
" Unglazed *
Collector heat lozs coeffficient 0.00 neeEe :_ ettt ™ WModest (20-60 % sky blocked)
; ) Pitch ME /M =
Dedicated solar storage (litres) 0.0a ™ Horizantal ¢ B0 degrees || € Motth " Mane ar very litle (<20 % sky blocked)
[~ Separate solar cylinder (" 3D degrees  “ertical
"~ 45 degrees I~ Solar powered purnp

Set the Efficiency of the community boiler, heat pump or CHP: the figure should be a
percentage.

If the community heating scheme has a combined heat and power (CHP) component
tick the is CHP box and set the CHP heat to power ratio value.

If the hot water cylinder is within the dwelling tick the box.

Use the drop-down to select the Heat distribution system.

If the dwelling has solar panels complete the Solar panel section of the Water heating tab (see
Eubsection 6.12.10).

6.12.10 Solar panels

Solar panels use sunlight to pre-heat water for the domestic hot water system. Guidance on
including solar panels in the calculation is given in Appendix H of the SAP documentation.
Where possible data from the panel's test certificate should be used, otherwise use data from
table H1 of the SAP documentation.

Where a dwelling has solar panels, specify:
= The net Aperture area of solar collector, in square metres.
* The Zero-loss efficiency of the collector.
» The heat loss coefficient of the collector.

* The volume of the dedicated solar storage. See figure H2 of the SAP documentation for
definitions.

e Whether there is a separate solar cylinder.
= The solar collector type, using the radio buttons.
= The pitch of the panels, measured from the horizontal, and their orientation.

= The amount of overshading on the panels; generally this will be less than the overshading
of windows facing the same direction.

e Whether there is a solar powered pump. This will reduce the amount of electricity used
for pumping water.
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Figure 6.24: The primary heating tab

Graup |Central heating systems with radiators or underfloor heating ﬂ
Sub-goup  |Gas boilers fincluding LPG] 1938 er later 4
System |Condensing [including combiz] with automatic ignition ﬂ
Boiler 1fuel  [Gas (mains) -
Heating contrals |Delayed start thermastat + programmer ﬂ

Heat emmiters

" Radiatars

" Underfloor, pipes in concrete slab

" Underfloor, pipes in insulated timber floor

" Underfloor, pipes in screed above insulation

[v Pump in heated space

" Baoiler has load or weather compenszatar
[~ Baoiler Interlock

[~ Separated consersatony with fised heater
[~ Dweling has fized air conditioning system
[~ Dweling is in smoke control area

Boiler efficiency
" Select from the boiler database. ..

Biaxi Potterton Combi 80 HE Flus GC Mo, 41-075-1E Efficiency -
90.80%

Use only For 1998 or later boilers.

Make: Madel |
Declared SEDBUK value, % |0.00
F.eep-hot facility Keep-hat fuel
o Mone (" Timed ¢ Undtimed | |{ Mainfuel  Elec.
" Usze default value Flue Diraught
* Un-known * Un-known
" Open " Matural
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~
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6.13 Primary heating

The primary heating system is the main heating system for the dwelling, which will often
provide hot water as well as space heating; it is usually not based on individual room heaters.

)_

Data on the primary heating system is entered using the Primary heating tab (Fig

6.13.1 The main primary heating systems

There are seven main groups of primary heating system: the following sections describe how
to enter data for the each group.
In each case, start by using the drop-boxes to set the:

* Group;
e Sub-group;
= System;

e Fuel;

= Heating controls: Note the software will test for the suitability of the selected heating
controls against criteria from the Domestic Heating Compliance Guide. Inappropriate
heating controls can cause a dwelling to fail its compliance check.

Always work from Group downwards, as the options in the lower drop-boxes change accord-
ing to the selections made higher up. Once you have set all the drop boxes you should enter
any other requirements for that group then enter any additional data.
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6.13.1.1 Central heating systems with radiators or underfloor heating
This group covers wet central heating systems with radiators, or pipes embedded in the floor:
the systems can be heated by boilers or heat pumps.

For most heat sources you must specify the efficiency of the boiler (the exceptions are electric
boilers and heat pumps). There are three sources of boiler efficiency data:

» The Boiler Efficiency Database (see fubsection 6.13.3). The database should be used for
calculations towards the end of the design process and beyond, once a specific boiler
has been chosen.

« A user-entered SEDBUK? value. Enter a SEDBUK percentage at the first stages of the
design process.

» A default value for the type of boiler. This is not recommended, as the default efficiencies
are poor, and make it difficult to obtain a pass.

To use the boiler database:

1. In the Boiler efficiency section select the Select from the boiler database radio button.

2. Click the Select boiler button. The Boiler Efficiency Database window opens. The issue
date of the database is shown in the bottom left of the dialogue.

3. Select the Boiler manufacturer. The list of that manufacturer's boilers is displayed, along
with the manufacturer's address.

4. Scroll down the list and click on a boiler to select it. You can scroll sideways to view
the details of each boiler, such as its efficiency and configuration.

The program only shows boilers which match the criteria you specified using the drop-
downs on the Primary heating tab. As a manufacturer does not necessarily offer a boiler
in every category the database may not display any boilers.

5. Click the Use selected boiler button. The Boiler database window closes and the Pri-
mary heating tab shows the summary details for the chosen boiler.
To enter a manufacturer's SEDBUK value
1. In the Boiler efficiency section select the Use manufacturer's declared SEDBUK value
radio button.

2. Enter the Make and Model of boiler and the Declared SEDBUK value. You will also
need to indicate the type and fuel of any Keep-hot facility and details of the Flue and
Draught type.

To use the default value:

3Seasonal Efficiency of Domestic Boilers in the UK
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1. In the Boiler efficiency section select the Use default value radio button. The software
shows the default value for that boiler type.

2. Use the radio buttons to enter the details of the Flue and Draught type.

For range cookers you must also enter the values for Ccase and “water.

Now specify the type of Heat emitters using the radio buttons and use the tick boxes to indicate
whether:

« the boiler pump is in the heated space;

« the boiler has load or weather compensator;

« the boiler has an interlock.

6.13.1.2 Storage radiator systems

Storage radiator systems are heated with off-peak electricity during the night and release that
heat throughout the day. The only data required is that from the primary heating drop boxes.

6.13.1.3 Warm air systems

The heat for warm air systems is provided by gas, oil, electricity or heat pumps. The only data
required is that from the primary heating drop boxes.

6.13.1.4 Room heater systems

This group includes room heaters such as gas or solid fuel fires. Some of the options will not
be appropriate for new-build, but are included for compatibility with RdSAP (Reduced data
SAP used for EPCs for existing dwellings).

The only data required is that from the primary heating drop-boxes. However, if you do know
the declared efficiency of the heater you should tick the box Use manufacturer's declared
efficiency then complete the Make, Model and Declared efficiency boxes and select the BS
Test Method used to obtain the efficiency.

6.13.1.5 Other space and water heater systems

There is currently only one heating system in this category: electric ceiling heating. The only
data required is that from the primary heating drop boxes.
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Figure 6.25: Data entry for community heating schemes

Group | Community Heating 5 cheme =
Community heating |Heat from bailers - gas ﬂ

Eailer 1 fuel | Gas [mains) |

Buler2fuel  [Gas fmaing) -

4
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Community heating

Community heating boiler 1 efficiency (%] |30.00 Fraction of heat from CHP unit |0.00
2 . Electrical efficiency of CHP
Boiler 1 heat fraction 0.750 it eq 0.25] 0.0000
Cammunity heating bailer 2 effisiency (%) |86.00 Heat efficiency of CHP unit
(29 0.5] 0.0000

Heat distribution spstem
Maing piping system installed before 1991, not pre-insulated, medium/high temp distibution [120/140°C), full flow systej

6.13.1.6 Community heating scheme

Community heating schemes use central heat generators -- usually boilers -- to heat water
which is then circulated through pipes to supply space heating and hot water to individual
dwellings. Heat may also be provided by Combined Heat and Power (CHP) systems, which
will also generate electricity. In rare cases a community heating scheme may provide hot
water but not space heating.

We recommend you consult Appendix C of the SAP documentation before specifying a com-
munity heating scheme.

To specify a community heating scheme:

1. Set Group to Community heating scheme. JPA Designer displays the Community heat-
ing section of the tab (see Figure 6.25).

2. In Community heating set the main heat source. This is important for community heating
schemes which have a CHP component, including heat from waste combustion. If there
is no CHP component you should set the Community heating to gas.

3. Set the Boiler 1 fuel. For a system with CHP this is the fuel for the back-up boiler. For a
non-CHP system this is the main heating fuel.

4. If there is a second boiler using a different fuel to the first one set the Boiler 2 fuel.
5. Set the Heating controls.
6. Set the efficiency of Community heating boiler 1: this is the efficiency of Boiler 1.

7. Set the Boiler 1 heat fraction: this is the proportion of heat provided by Boiler 1 and
will be between 0.00 and 1.00. If there is only one boiler leave the value as 1.00.

8. Set the efficiency of Community heating boiler 2: this is the efficiency of Boiler 2. If
there is no second boiler leave this at 0.00.
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9. If the scheme has CHP or waste combustion, set the Fraction of heat from CHP unit.
For all other schemes leave this at 0.00.

10. If there is CHP set the Electrical efficiency of the CHP unit as a ratio between 0.00 and
1.00. For all other schemes leave this at 0.00.

11. If there is CHP set the Heat efficiency of the CHP unit as a ratio between 0.00 and 1.00.
For all other schemes leave this at 0.00.

12. Use the Heat distribution system drop-box to specify the type of pipes used to circulate
the hot water.

6.13.1.7 Electric underfloor heating

This section is for underfloor heating systems based on electric cables in the floor slab or
integrated into flooring.

The only data required is that from the primary heating drop boxes.

6.13.2 Additional data

There are some items of additional data which the software collects for producing the EPC.
Three items can appear on the Primary heating tab:

= Separated conservatory with fixed heater: Tick this box if the dwelling has a thermally
separated conservatory (see SAP guidance section 3.3.3 for the definition of thermally
separated) which has a fixed heater within it.

« Dwelling has fixed air conditioning system: Tick the box if there is a fixed air condi-
tioning system in the dwelling.

* Dwelling in smoke control area: This box is only relevant if solid fuel is set as the
fuel for the primary or secondary heating. If the dwelling is within a smoke control
zone the use of house coal and dual fuel is not permitted, and wood is only permit-
ted for an exempted appliance. For further information on smoke control areas see
www.smokecontrolareas.co.uk. Tick the box if the dwelling is within a smoke control
area.

6.13.3 The Boiler Efficiency Database

The Boiler Efficiency and Products Characteristics Database contains performance data for
most central heating boilers available in the UK as well as data on mechanical ventilation sys-
tems. The database is maintained by the BRE and is available for download at www.boilers.org.uk.
A new version of the database is issued at the end of every month.

To ensure you are using an up-to-date version of the database, JPA Designer checks the issue
date every time you start the program: if the database is more than two months old the software
prompts you to download the latest version. You can also download the database yourself.

To download the database:
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1. With your web browser go to www.boilers.org.uk.
2. On the home page click on Download the Boiler Efficiency Datafile.

3. Right click on the Download button for SAP 2005 -- unzipped file (.dat), and choose
Save target as. The download begins.

The .dat file is larger than the others, but is simpler to install. On a broadband internet
connection the difference in size is negligible.

4. In the Save As dialogue select the /PA Designer 981 folder and accept the suggested file
name bedf2005.dat.

5. At the warning bedf2005.dat already exists. Do you want to replace it click Yes.

6. At the Download complete dialogue click Close. The database is now updated.

6.13.4 Identifying the primary heating system

In some cases -- usually existing dwellings -- it may be difficult to identify the primary heating
system. In such cases, any central heating system which provides space and water heating
and can heat at least 30% of the dwelling should be treated as the primary heating system. If
there is no system which provides space and water heating the primary heating system should
be that which can heat the greatest part of the dwelling. If there is still doubt, select the system
which supplies useful heat to the dwelling at lowest cost.

Where there are two central heating systems, the SAP calculation should be carried out using
data on the system which heats the largest part of the property. See SAP 2005 Appendix A for
further guidance on the treatment of primary and secondary heating systems.

6.14 Secondary heating

A secondary heating system provides additional heating for the dwelling. Compliance calcu-
lations presume a proportion of the space heating demand is provided by a secondary heating
system: the proportion is defined in table 11 of the SAP 2005 documentation.

Data on secondary heating is specified using the Secondary heating tab (Figure 6.26). The
choice of secondary heating system can have a significant effect on the DER. Approved Doc-
ument LTA paragraph 28 contains guidance on secondary heating in DER calculations.

To enter secondary heating data:

1. Set the Group drop-down to Room heater systems.

If you select None the software will presume electric panel heaters.
2. Select the Sub-group.
3. Select the System.
4. Select the secondary heating Fuel.

If the solid fuel room heater has been approved by HETAS* tick the box. This will improve the
default efficiency used for the heater.

If you know the actual efficiency for a solid fuel heater you should tick the Use manufacturer's
declared efficiency box then enter the Make, Model and Declared efficiency. You must also
select the BS Test Method used to obtain the efficiency value.

“Heating Equipment Testing and Approval Scheme.
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Figure 6.26: The Secondary heating tab

Graup | Foom heater systems ﬂ
Sub-raup | Solid fuel =
System |Elosed room heater ﬂ
Fuel [\wood logs =l

[~ Solid fuel room heater is HETAS approved

[ Usze manufacturer's declared efficiency

Make |Morso todel |31 42

Declared efficiency, 2 |81.00

BS TestMethod |BS EN 13240 2

6.15 Ventilation

The movement of air from the inside to the outside of the dwelling will result in heat loss. SAP
considers two components of air movement:

= Air infiltration through the building fabric.

* Ventilation.

Data for air movement is entered using the Ventilation tab, which has sections for air infiltra-

tion and ventilation strategy (see Figure 6.27).

6.15.1 Air infiltration

Air infiltration represents unplanned air movement: higher levels of air infiltration will give
higher DER values. The rate of air infiltration is expressed in terms of cubic metres of air
moving through a square metre of exposed building surface each hour, m®/m2hr: the measure
is often referred to as the g50 value, after the calculation result in BS EN 13829.

The DER calculation does not require any specific value for air infiltration, but Part L imposes
upper compliance limit of 10 m3/m?hr for all dwellings, which will be checked by pressure
testing®. Design stage calculations have to be revised using the actual infiltration rate once
testing has been carried out.

The only exception to that regime is for developments of one or two dwellings, where an air
pressure test is not required, so long as the DER is calculated using an air infiltration rate of
15 m3/m2hr. That presumed rate of air infiltration will give a higher DER, which must then
be reduced by compensating improvements to the building fabric or services.

There are three methods to enter the air infiltration data into the software:

SPressure testing is not required in Scotland if the DER is calculated using an air permeability value of 10 for
dwellings with accredited construction details and 15 for dwellings without accredited construction details.
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Source of bl value Prezsunization Test Result

" Pressure Test @+

[~ Small development - no pressure testing caried out Canstruction stage
Wentilation First measured gb0 [ré/mé k) ’W
Mumber of chimneys m First pressure test date ,7
Number of flues m [~ Dwelling failed first pressure test

Mumber of flueless gas fires 1] = Second pressure test date
Mumber of sheltered sides 20

Figure 6.27: The Ventilation tab
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" Matural ventilation with passive stack vertilators

" Balanced whole house mechanical ventilation without heat recovery
" Balanced whole house mechanical ventilation with heat recoveny
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~
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~

-

Positive input ventilation from loft
Mechanical whale house extract ventilation
Decentralised mechanical whole house extract ventilation

Source of mechanical ventilation parameters

et E 100 i dwelli hich
. = *Enter or hew dwellings which are ko
" Userdefined _Enter details.. comply with the Building Regulations

{* Database Lookup.. | Johnson Starley CE180 Premier

% of windows & doors draught stripped * |100.0

» Set a design test pressure, and replace it later by the result of the pressure test.

= On small developments, use an assumed value of 15 m3/m?2hr.

» Allow the software to calculate the infiltration rate from the construction type and build-

ing size. This method is not valid for demonstrating compliance under building regula-
tions.

To use pressure test data:

1

2.

. In the Source of q50 value section select Pressure test.

Enter the design pressure test value in the Design q50 box: the value should not exceed
10.

For design stage calculations set the radio buttons to as designed. No further data is
required.

For post completion calculations set the radio buttons to as built. The tab shows the
Construction stage section.

Enter the First measured q50 and the First pressure test date.

If the dwelling failed the first pressure test and a second was required tick Dwelling
failed first pressure test and enter the Second measured q50 and the Second pressure
test date
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To use an assumed value for air pressure:

1.

In the Source of 50 value section select Assumed value. The Design ¢50 box is set to
15 m3/m2hr: this value cannot be changed.

2. Tick the Small development box, which indicates the dwelling is part of a development

of one or two dwellings. If you do not tick the box the dwelling will fail its compliance
checks.

To use a calculated value:

1.

In the Source of q50 value section select Calculation. The tab shows additional text
boxes.

. Specify:

« the Type of construction;

» whether there is a draught lobby;
= the floor construction;

e the number of storeys.

3. The software then calculates an air permeability rates based on the SAP defaults.

In all cases, leave the box 100% draught-stripping ticked.

6.15.2 Ventilation strategy

In the Ventilation section enter details of the ventilation provision for the dwelling. Use the
boxes to enter the numbers of:

Chimneys: vertical ducts for combustion gases with diameter greater than 200 mm.
Flues: vertical ducts for combustion gases with diameter less than 200 mm.

Extract fans and passive vents: intermittent extract fans in bathrooms and toilets and
passive vent systems.

Flueless gas fires.

Number of Sheltered sides to the dwelling. Sheltered sides reduce the rate of air infil-
tration resulting from exposure to wind forces.

See sections 2.1 and 2.2 of the SAP 2005 documentation for further guidance.

In the Ventilation type section use the radio buttons to select the ventilation strategy for the
dwelling. If you are specifying whole house ventilation or extract systems you should consider
using data for a specific system rather than relying upon the default values within SAP which
will give a poor result.

You can enter data on the system yourself, or use the BRE mechanical ventilation database
which holds performance data on a wide range of mechanical ventilation and extract systems.
The BRE database is built-in to JPA Designer.

To enter user defined data for ventilation or extract systems
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Figure 6.28: The BRE Ventilation Database dialogue
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1. From the Source of mechanical ventilation parameters select User defined.
2. Click the Enter details button. The User defined ventilation parameters dialogue opens
and you can now enter the data.

To use ventilation data from the BRE ventilation database:

1. From the Source of mechanical ventilation parameters select Database.

2. Click the Lookup button. The Mechanical Ventilation Database dialogue opens (see

o 6.23).
3. Use the drop-down to select the Manufacturer. The list of available products appears.
4. Select a product by clicking on it.

5. Specify the number of Wet rooms excluding kitchen.

6. If the ductwork is insulated tick the Insulated duct box.

7. Click the Use the selected system button. The dialogue closes and the summary of the
system is displayed next to the Database radio button.
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Figure 6.29: The Overheating tab
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6.16 Overheating

Dwellings must not have an excessive risk of high internal temperatures in summer as a result
of solar gain. The test for overheating risk is set out in Appendix P of the SAP document;
overheating risk depends on the predicted amount of solar gain and the thermal mass of the
dwelling.

Because JPA Designer takes most of the information for the calculation from the SAP data
there are only three items to enter in the Overheating tab (see Figure 6.29).

= Building region: selecting the region from the drop-down sets the mean summer tem-
perature, with higher mean temperatures more likely to result in overheating.

« Effective air-change rate: a higher air change rate will reduce the risk of overheating.
You can either tick the Enter value box and enter a design air change rate, in air changes
per hour (ach), or use the Building and Window opening drop-downs to set default
values.

» Thermal mass parameter: this represents the amount of heat which the building fabric
can absorb. Dwellings with higher thermal mass absorb more heat and are less likely
to overheat than those with lower thermal mass. You can either use the list to select the
construction which best matches that of the dwelling, or enter a calculated value in the
Thermal Mass Parameter box.

The result of the overheating assessment is shown in the main SAP window: a dwelling with
a high risk of overheating will not comply with regulations.

If appropriate tick the Dwelling incorporated fixed air conditioning. This does not affect the
SAP calculation, but will appear on the Energy Performance Certificate.
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Figure 6.30: The Photovoltaics and Alternative Technology tab

Photavoltaics

Photovoltaics - peak khw 0.00

Pitch Direction Overshading
(" Horizontal (" South ™ Heawy (>80 2 sky blocked)
™ 30 degrees ™ SE/ShW

" Significant [>60-80 % sky blocked)

(" 45 degrees " EastMwest & Dl DB ol
£ 60 degrees  NEMNW ¢ Modest (2080 % sky blocked]
~ ertical ~ Narth " Mone or very little [<20 % sky blocked)

Special features / new energy-saving technologies [Appendix (]

Diescription of new technology |
Ernergy zaved [Kwhivear] |0.00 Type of fuel saved |
Energy uzed [Kwhdipear] |0.00 Tvpe of fuel uzed |

Ll L

Micra wind turbines on the building or within its curtilage

Mumber of turbines ’07

Rotor diameter (m) |0.000

Terrain type ’W
Height of turbine W

hub above ridge
of roof [m]

6.17 Photovoltaics and micro wind turbines

SAP 2005 takes account of the contribution of Photovoltaic panels and wind turbines to the
energy consumption of the dwelling and the resultant CO, emissions. Wind turbines can
either be fitted to the roof of the dwelling or on a mast within the curtilage of the dwelling.

Use the Photovoltaics and Alternative Technologies tab (abbreviated to PV & Alt Tech) to

enter data (see figure Figure 6.30).

To include data on Photovoltaic cells:
1. Enter the peak kW of the system (obtain this value from the manufacturer or supplier);
Select the Pitch of the panels;

Select the Direction which the panels face;

Now N

Select the amount of Overshading (which may not be the same as the overshading of
the windows);

To include wind turbines:
1. Enter the Number of turbines.
2. Specify the Rotor diameter in metres.
3. Select the type of terrain which surrounds the dwelling.
4. Enter the height of the hub of the turbine above the ridge of the roof, in metres.

As part of the process of producing an EPC the software must calculate the likely benefit from
installing a wind turbine. You should therefore specify the Terrain type even if there is no
wind turbine on the dwelling.
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6.18 Special features

SAP 2005 includes a method for including the effects of new technologies which are not
included in the original methodology. The method, which is described in SAP 2005 Ap-
pendix Q, may only be used for products which are independently assessed and listed on the
Appendix Q web site at http://www.sap-appendixq.org.uk. The web site has a calculation
spreadsheet for the various product types® and data sheets for individual products.

To use the appendix Q method you first complete the appropriate calculation spreadsheet:
this requires information on the product taken from its datasheet, and may involve changes to
the SAP calculation. Then you transfer the results from the spreadsheet to the Special features
section of the Photovoltaics and Alternative Technologies tab.

To enter Appendix Q results:

1. Enter a brief Description of the technology, e.g. flue gas heat recovery or whole house
ventilation.

2. Enter the Energy saved figure from the spreadsheet and use the drop-down to select the
Type of fuel saved.

3. Enter the Energy used figure from the spreadsheet and use the drop-down to select the
Type of fuel used

6.19 Checking compliance

Once you have entered all the data for the dwelling you can check its compliance status.
The program will display pass (green) or fail (red) in the compliance zone at the bottom right
corner of the main SAP window. If the dwelling fails you can hold your curser over over the
compliance zone and the software will display a tool-tip will show the primary cause of failure

(see Figure 6:2).

Click on the compliance zone to open the Compliance Checklist which lists the main cri-
teria the the SAP module tests and shows the status of the dwelling against each one. The
compliance check window is particularly useful when the dwelling has failed on one of the
secondary criteria, such as the efficiency of heating controls.

You can use the tabs at the bottom of the Compliance Checklist to view:

the SAP worksheet;

the TER worksheet;

the DER worksheet;

the Overheating risk assessment.

Once you have reviewed the results you can then make changes to the calculation.

bThere are separate spreadsheets for SAP 9.80 and SAP 9.81: make sure you use the appropriate version.
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Figure 6.31: SAP Sections To Print dialogue
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6.20 Outputting SAP results

You can print the results of SAP calculations or produce a PDF file which can be opened on
any computer with the free Adobe Reader software installed; PDF files are ideal for emailing.
For both print and PDF you can select which parts of the results you want to include in your
output:

* SAP worksheet: the results of the SAP calculation.

* TER worksheet: the results of the TER calculation for the notional dwelling.

» DER worksheet: the results of the DER calculation for the actual dwelling.

* Input data: a reflection of the information you have entered into the software.

* Regulations checklist: shows the compliance status of the dwelling in a checklist which
follows the format in AD LTA.

= Summer overheating: results of the overheating assessment.

» Summary (certificate): one page showing the SAP rating for the dwelling.

This option is not available (greyed out) if the dwelling does not comply with regulations.

= Energy performance certificate (EPC): a draft energy performance certificate.
You must be a member of an appropriate accreditation scheme to produce a final EPC
-- see the separate guidance document for instructions.

e Predicted Energy Assessment (PEA): the energy assessment required at the design stage.
In order to produce a PEA tick both Energy Performance Certificate and Predicted En-
ergy Assessment.

To print the results:

1. Select File=Print from the menu bar (or click the Print button on the tool bar). The
Sections To Print dialogue opens (see (Figure 6.31)).
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. Use the tick boxes to select the outputs you want to produce.

. Click OK. The Print preview window opens (see Figure 4.19).

. Use the buttons on the tool bar to view successive pages of the print out, then click the
Print button to print the pages.

To create a PDF file of the results:

1. From the menu bar select File=Create PDF. A dialogue asks if you want to open the

PDF when it is created.
. Select Yes or No. The Sections To Print dialogue opens (see Figure 6.31).

. Use the tick boxes to select the outputs you want to produce.

. Click OK. The Print preview window opens (see Figure 4.19).

. Use the buttons on the tool bar to view successive pages of the print out, then click the
Print button to print the pages. The program will then create a PDF file of the calculation.

*The name of the PDF file will include the JPA Designer file name and the calculation
name, so the calculation Plot 28 in a project The Meadows will be called The Mead-
ows.JDPtile hung wall.Plot 28.PDF. The file will be saved into the JPA Designer program
folder or in the start-up folder you have specified.

Note: as Windows does not allow certain characters to be used in file names you should
ensure the calculation names in JPA Designer do not contain those characters, otherwise
PDF creation will fail. The restricted characters are '/ \: ¥ 2 <> |.

You can change the printer settings by selecting File=>Printer setup from the menu bar.



7 Other SAP calculations

7.1 Converting 9.80 calculations to 9.81

Calculations carried out in JPA Designer to SAP 2005 version 9.80 can be converted to 9.81
calculations. This is particularly useful where the original compliance calculations were to
9.80, and a 9.81 calculation is required in order to issue an EPC.

To convert a 9.80 calculation to 9.81:

1. In Project Manager make a duplicate of the original calculation (see Fection 3.12).
2. Double click on the duplicate calculation to open it.

3. From the menu bar select Edit>Project information. The Project Information dialogue

opens (see pection b.7).
4. Tick the box SAP 9.81 and select the Building type and Location, then click OK.

You will need to review the input data for the calculation to ensure you have addressed the
new items in version 9.81.

7.2 Multiple dwellings

Because SAP ignores heat loss through party walls and separating floors, it can be extremely
difficult to demonstrate the necessary reduction in carbon dioxide emissions for mid-block
apartments and terraced houses, even with standards of fabric and building services which
would easily allow a detached house to pass. Approved Document L1A allows you to using
average TER and DER values for apartments and terraced houses, so higher performing units
(those on the end of terraces or ground and top floors of apartment blocks) can compensate
for the poorer performance of units in the middle or blocks or terraces.

JPA Designer includes a multiple dwelling feature to carry out the average TER and DER cal-
culations. The Multiple dwellings SAP window (Figure 7-1) has two panes: the left-hand
one (labelled Available SAP V98 Dwellings) lists all the SAP 9.81 dwellings within the project
which are eligible for inclusion in the multiple dwellings calculation. The right-hand pane (la-
belled Dwellings in this multiple dwelling) lists all the dwellings which are currently included
in the multiple dwellings calculation.

The Add and Remove buttons transfer selected dwellings between the panes. The results of
the multiple dwellings calculation are shown below the panes, together with the compliance
status. In order to pass the Average DER must be equal to or less than the Average TER.

To carry out a multiple dwelling calculation:

97
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Figure 7.1: The SAP window for a multiple dwellings calculation
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1. Carry out normal SAP calculations for all the units in the block.
You may need to duplicate some calculations to ensure you have one for each flat. Note
that if a block is in two identical halves it may be enough to consider only one half).

2. In Project Manager select Insert=Dwelling/SAP (v9.81 2005) calculation>Multiple
dwelling. The Description dialogue opens (Figure 3.3)).

3. Type a name for the calculation in the Description dialogue, e.g. Block B all flats, and
click OK. The new calculation is added to the project.

4. In Project Manager, double click on the new calculation. The Multiple dwellings SAP

window opens (Figure 7-1)).

5. Click on a dwelling in the Available SAP v98 Dwellings pane to select it, then click the
Add button. The dwelling is transferred to the Dwellings in this multiple dwelling pane.

6. Repeat the previous step until you have all the dwellings you need in the right-hand
pane.

If you need to remove a dwelling from the multiple dwelling calculation simply select it
and click the Remove button.

You can print the results of multiple dwelling calculations and produce PDFs by following the

procedures in Fection 6.21

7.3 Extensions to existing dwellings

The energy efficiency of extensions and conversions is addressed in Approved Document L1B,
where the primary compliance method is an elemental approach. JPA Designer can be used
to carry out the required U-value calculations.
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In some circumstances, where it is not possible to achieve the required U-values, you can
use two SAP calculations to demonstrate compliance. The first calculation should be for the
dwelling with an extension which complies with the elemental U-value standards, whilst the
second shows the dwelling with the proposed extension. If the “proposed' calculation has a
lower DER than the “compliant' then the extension will have a lower heat loss rate than that
required by the regulations.

As this methodology is not explicitly described in the approved document you should consult
the Building Control body to agree its acceptability.
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